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1 Guide to this manual

1.1 Introduction

This User Manual concerns the tidal analysis module, Delft3D-TIDE, of the Delft3D software
suite.

The Delft3D-TIDE software package consists of the following sub-systems:

ANALYSIS Harmonic analysis of tidal observation registrations.
PREDICT Prediction of tidal water levels or tidal currents.
HILOW Preparation of tide tables.
ASCON Computation of tidal frequencies.
FOURIER Fourier analysis of time-series.

To make this manual more accessible we will briefly describe the contents of each chapter
and appendix.

If this is your first time to start working with Delft3D-TIDE we suggest you to read and practice
the getting started of chapter 3 and the tutorial of chapter 7. These chapters explain the user
interface options and guide you through the definition of your first calculation.

Chapter 2: Introduction to Delft3D-TIDE, provides specifications of Delft3D-TIDE.

Chapter 3: Getting started, explains the use of the overall menu program, which gives
access to the Delft3D-TIDE module.

Chapter 4: Menu options, provides the description of the different menu options on the main
menu of Delft3D-TIDE.

Chapter 5: General operation of the Delft3D-TIDE subsystems, describes the operation
of the several subsystems of Delft3D-TIDE.

Chapter 6: Graphics, list the post-processing tools from the Delft3D suite which can be used
in relation with Delft3D-TIDE.

Chapter 7: Tutorial, emphasis at giving you some first hands-on experience in using the
several modules of Delft3D-TIDE.

Chapter 8: Conceptual description, describes the theory behind Delft3D-TIDE.

References, provides a list of publications and related material on the Delft3D-TIDE module.

Appendix A: Input file formats, gives a description of the input file formats of the subsystems
ANALYSIS, PREDICT, HILOW and ASCON.

Appendix B: List of tidal components (internal component base), gives a description
of all the tidal components use in Delft3D-TIDE (234); component name, frequency [◦/h],
amplitude in equilibrium tide and amplitude coupling relations.

Appendix C: Filename conventions, the required file name convention for each subsystem
of Delft3D-TIDE is given.

Appendix D: Messages from Delft3D-TIDE, the error, warning and informative messages
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of Delft3D-TIDE are given in this appendix.

Appendix E: Content of the TIDE tutorial cases, the content of the tutorials for Delft3D-
TIDE is given in this appendix.

1.2 Manual version

A manual applies to a certain release of the related numerical program. This manual applies
to Delft3D-TIDE version 5.00.

1.3 Typographical conventions

Throughout this manual, the following conventions in text formats help you to distinguish be-
tween different types of text elements.

Example Description

Module
Project

Title of a window or a sub-window are in given in bold.
Sub-windows are displayed in the Module window and
cannot be moved.
Windows can be moved independently from the Mod-
ule window, such as the Visualisation Area window.

Save Item from a menu, title of a push button or the name of
a user interface input field.
Upon selecting this item (click or in some cases double
click with the left mouse button on it) a related action
will be executed; in most cases it will result in displaying
some other (sub-)window.
In case of an input field you are supposed to enter input
data of the required format and in the required domain.

<\tutorial\wave\swan-curvi>
<siu.mdw>

Directory names, filenames, and path names are ex-
pressed between angle brackets, <>. For the Linux
and UNIX environment a forward slash (/) is used in-
stead of the backward slash (\) for PCs.

“27 08 1999” Data to be typed by you into the input fields are dis-
played between double quotes.
Selections of menu items, option boxes etc. are de-
scribed as such: for instance ‘select Save and go to
the next window’.

delft3d-menu Commands to be typed by you are given in the font
Courier New, 10 points.

In this User manual, user actions are indicated with this
arrow.

[m s−1] [−] Units are given between square brackets when used
next to the formulae. Leaving them out might result in
misinterpretation.
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1.4 Changes with respect to previous versions

Version Description

1.0 5 header lines were expected in all input files, without any restriction to the first
character of each header line.

2.01 a ’+’ is inserted as first character in each header line.

5.00 New overall GUI to support spaces in directories and filenames.

Memory of PREDICT increased to 550 000, a prediction of one year with a time
interval of one minue is now possible (550 000 > 531 360 = 369×24×60).

Maximum memory allocation for dynamic storage increased to 550 000.

Number of time-series for Standard Fourier Transform and Fast Fourier trans-
form is increased to 550 000 to support the synodic period of 369.0 days.
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2 Introduction to Delft3D-TIDE

In most continental shelf seas, coastal seas and estuarine areas the astronomical tide is the
main driving force of the water motion. At times equally important is the motion induced by
meteorological phenomena like wind and storms. Consequently, for almost all activities along
the coast and offshore, a sound knowledge and understanding of the behaviour of water level
and current is required. Tidal analysis and tidal prediction are of great help in this.

Local water level or current registrations of at least one month can be analysed to separate the
astronomical part from the meteorologically induced part of the observation. The so obtained
tidal constants fully determine the local tide, and can be used to predict the astronomical water
level or current, respectively, for any period in the past or future.

Deltares program system Delft3D-TIDE has been especially designed to perform tidal anal-
ysis and tidal prediction for various complicated situations. It has been used extensively in
numerous studies at more than 400 locations world-wide.

The following sections give an extensive description of the various sub-systems.

Section 5.1, ANALYSIS Tidal analysis of observed series.
Section 5.2, PREDICT Tidal prediction.
Section 5.3, HILOW Preparation of tide tables.
Section 5.4, ASCON Calculation of astronomical factors.
Section 5.5, FOURIER Fourier analysis of time-series (standard and fast Fourier trans-

form).
Chapter 6, Graphics Graphical presentation of time-series or spectral series using

Delft3D-QUICKPLOT and GPP.

It includes a general introduction on how to run the system, a step by step description of
the input file(s), how to interpret the output files and remedies, a list of error messages and
warnings including explanations is given in Appendix D.

2.1 Global description of the sub-systems
Analysis Harmonic analysis of tidal observation registrations. Options: astronomical cou-

pling, multiple instruments, sub-series to account for data gaps, linear trend,
accuracy analysis.

Predict Prediction of tidal water levels or tidal currents for given periods on the basis of
a set of tidal constants.

Hilow Preparation of tide tables (tables with times and heights of high and low water)
for the period of the supplied time-series. The latter may be an observation, a
hindcast or a prediction.

Ascon Computation of tidal frequencies, astronomical arguments and nodal factors for
any tidal component and any date time group.

Fourier Fourier analysis of time-series.

For plotting relevant output files (time-series as well as spectral series) we refer to the graphi-
cal programs GPP (GPP UM, 2013) and Delft3D-QUICKPLOT (QUICKPLOT UM, 2013).

2.2 How to install the software

See Delft3D Installation Manual (Delft3D IM, 2013).
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3 Getting started

3.1 Delft3D-TIDE as Delft3D module

To start Delft3D:

� On an MS Windows platform:

Select Delft3D in the Applications menu or click on the Delft3D icon on the desktop.
� On Linux:

Type delft3d-menu on the command line.

Next the title window of Delft3D is displayed, Figure 3.1.

Figure 3.1: Splash window of Delft3D

After a short while the main window of the Delft3D-MENU appears, Figure 3.2.

� Whether or not you may have support on Delft3D modules, depends on the support con-
tract you have.

For now, only concentrate on exiting Delft3D-MENU, hence:

Press the Exit button.

The window will be closed and you are back in the Windows Desk Top screen for PCs or on
the command line for Linux.

Remark:
� In this and the following chapters several windows are shown to illustrate the presen-

tation of Delft3D-MENU and Delft3D-TIDE. These windows are grabbed from the PC-
platform. For Linux workstations the content of the windows is the same, but the colours
may be different.

3.2 Getting into Delft3D-FLOW and Delft3D-TIDE

To continue restart the Delft3D-MENU program as indicated above.

Click on button Flow.
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Figure 3.2: Main window Delft3D-MENU

Next the selection window for Hydrodynamics (including morphology) is displayed for
preparing a flow or flow/wave input, to execute a computation in foreground or in batch, to
inspect the report files with information on the execution and to visualise the results: Fig-
ure 3.2. Delft3D-TIDE is part of the additional tools.

Figure 3.3: Selection window for Hydrodynamics

Before continuing with any of the selections of this Hydrodynamics (including morphology)
window, you must select the directory in which you are going to prepare scenarios and execute
computations:

Click the Select working directory button.

Next the Select working directory window, Figure 3.4, is displayed (your current directory
may differ, depending on the location of your Delft3D installation).
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Figure 3.4: Select working directory window

Figure 3.5: Select working directory window to set the working directory to
<tide\analysis\example_1>

Browse to the <Tutorial> sub-directory.
Enter the <tide> directory, and next the <analysis> directory.
Enter the <example_1> sub-directory and close the Select working directory window
by clicking OK, see Figure 3.5.

Next the Hydrodynamics (including morphology) window is re-displayed, but now the
changed current working directory is displayed in the title bar, see Figure 3.6.

Remark:
� In case you want to start a new project for which no directory exists yet, you can select

in the Select working directory window to create a new directory.

Figure 3.6: Current working directory
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Figure 3.7: Additional tools for the Delft3D-FLOW module

In this guided tour through Delft3D-TIDE we limit ourselves to the point where you start
Delft3D-TIDE. Hence:

Select Tools in the Hydrodynamics (including morphology) window.

The Additional Tools window is displayed, see Figure 3.7.

The additional tools for Delft3D-FLOW are verifying the input file, nesting (Delft3D-NESTHD
1 and Delft3D-NESTHD 2), tidal analysis of Delft3D-FLOW time-series (Delft3D-TRIANA),
tidal analysis and prediction of tides (Delft3D-TIDE), data selection from NEFIS file, linear
integration and volume integration, see Figure 3.7.

To start Delft3D-TIDE:

Select TIDE.

Next the opening window of Delft3D-TIDE is shown, see Figure 3.8.
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Figure 3.8: Main window of Delft3D-TIDE

3.3 Exiting Delft3D-TIDE

Before running Delft3D-TIDE you have to prepare the input files, see section 5.1.2, 5.2.2,
5.3.2 and 5.4.2.

Click File→ Quit to exit Delft3D-TIDE, see Figure 3.9.

Figure 3.9: Menu toolbar, option File→ Quit

You will be back in the Additional tools window of the Delft3D-MENU program, Figure 3.7.

3.4 Exiting Delft3D

To return to the main Hydrodynamics (including morphology) selection window:

Click Return

You will be back in the Hydrodynamics (including morphology) window of the Delft3D-
MENU program, Figure 3.3.

Ignore all other options:

Click Return to return to the main window of Delft3D-MENU, Figure 3.2.
Click Exit.

The window is closed and the control is returned to the desk top or the command line.
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In this Getting Started session you have learned to access the Delft3D-TIDE module as part
of the Delft3D-FLOW module.

We encourage users next to read chapter 5 and practice with the tutorial examples given in
chapter 7.
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4 Menu options

The menu bar contains the items File, Subsystem and Help, see Figure 4.1, each item is
discussed in a separate section.

Figure 4.1: Delft3D-TIDE menu options

4.1 File menu

On the File menu the options Open and Quit are available see Figure 4.2.

Figure 4.2: File menu options

4.1.1 Open

Upon selecting File→ Open, you can open the input files of a subsystem of Delft3D-TIDE.
The file selection filters are dependent on the chosen subsystem.

4.1.2 Quit

Upon selecting File→ Quit the Delft3D-TIDE program will close.

4.2 Subsystem menu

On the Subsystem menu, the subsystems of Delft3D-TIDE can be selected, see Figure 4.3.

Figure 4.3: Subsystem menu options
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4.2.1 Analysis

When selecting Subsystem→ Analysis the program to analyse time-series is selected, but
first (if needed) the file open window will appear to select the appropriated input files. To start
the time series analysis, press the button Start Analysis, see Figure 4.4.

Figure 4.4: TIDE - Analysis subsystem window

4.2.2 Prediction

The subsystem Prediction, to compute the astronomic predictions, consist of two systems,

1 a Graphical User Interface, and
2 a computational core to perform the calculation,

see Figure 4.5.

Figure 4.5: Subsystem Predict menu options
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4.2.2.1 Prediction GUI

When selecting Subsystem → Predict → GUI the user interface program to calculate the
predictions is selected, but first (if needed) the file open window appear to select the appro-
priated input files. To start the prediction user interface, press the button Start Predict GUI,
see Figure 4.6.

Figure 4.6: TIDE - Prediction GUI subsystem window

4.2.2.2 Prediction Calculation

When selecting Subsystem → Predict → Calculation the program to calculate the predic-
tions is selected, but first (if needed) the file open window appear to select the appropriated
input files. To start the calculation of the predictions, press the button Start Prediction, see
Figure 4.7.
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Figure 4.7: TIDE - Prediction subsystem window

4.2.3 High/Low

The subsystem High/Low, to compute the high and low water time tables consist of two sys-
tems,

1 a Graphical User Interface, and
2 a computational core to perform the calculation,

see Figure 4.5.

Figure 4.8: Subsystem High/Low menu options
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4.2.3.1 High/Low GUI

When selecting Subsystem→ High/Low→ GUI the user interface program to calculate the
high and low water level tables is selected, but first (if needed) the file open window appear to
select the appropriated input files. To start the user interface, press the button Start High/Low
GUI, see Figure 4.9.

Figure 4.9: TIDE - High/Low water GUI subsystem window

4.2.3.2 High/Low Calculation

When selecting Subsystem→ High/Low→ Calculation the program to calculate the high and
low water level tables is selected, but first (if needed) the file open window appear to select
the appropriated input files. To start the calculation of the tide tables, press the button Start
High/Low, see Figure 4.10.
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Figure 4.10: TIDE - High/Low water subsystem window

4.2.4 Ascon

When selecting Subsystem→ Ascon the program to analyse time-series is selected, but first
(if needed) the file open window appear to select the appropriated input files. To start the
calculation of the astronomic constants, press the button Start Ascon, see Figure 4.11.

Figure 4.11: TIDE - Ascon subsystem window
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4.2.5 Fourier

Two Fourier methods are available to analyse series, you can choose between a Standard
Fourier Transform (SFT) or a Fast Fourier Transform (FFT) method, see Figure 4.12.

Figure 4.12: Subsystem Fourier menu options

4.2.5.1 Standard Fourier Transform

When selecting Subsystem → Fourier → Fourier SFT the program for Standard Fourier
Transform is selected, but first (if needed) the file open window appear to select the appro-
priated input files. To start the standard fourier transform, press the button Start SFT, see
Figure 4.13.

Figure 4.13: TIDE - Standard Fourier Transform subsystem window
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4.2.5.2 Fast Fourier Transform

When selecting Subsystem→ Fourier→ Fourier FFT the program for Fast Fourier Transform
is selected, but first (if needed) the file open window appear to select the appropriated input
files. To start the fast fourier transform, press the button Start FFT, see Figure 4.14.

Figure 4.14: TIDE - Fast Fourier Transform subsystem window

4.3 Help menu

On the Help menu, you can choose to read the user manual or list the version number of
Delft3D-TIDE, see Figure 4.15.

Figure 4.15: Subsystem menu options

4.3.1 User Manual

When clicking on the Help→ User Manual, the user manual of Delft3D-TIDE will be displayed.

4.3.2 About

When clicking on the Help → About, a window will display the current version number of
Delft3D-TIDE.
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5 General operation of the Delft3D-TIDE subsystems

5.1 ANALYSIS

A rather extensive theoretical background of tidal analysis is given in section 8.3. Special
features are discussed in section 8.4. It is advised to refresh your knowledge — if needed —
by reading these sections.

5.1.1 Running the system
Start Delft3D-TIDE, see Chapter 3,

ANALYSIS operates in a file oriented way. That means that you have to prepare your input files
before you can start the system successfully. From the data on the input files the computa-
tional process starts, resulting in a number of output files. The print file with a complete report
of the computation provides you with an impression of the results. For file name conventions,
see Appendix C.

ANALYSIS needs input data from two files, the input data file (with the required extension
<ina>) and the file with observations (with the required extension <obs>), the file descrip-
tions are given in section A.1. Here we expect both input files to be ready for use.

Select Subsystem→ Analysis, see Figure 5.1.

Figure 5.1: Menu option Subsystem→ Analysis.

If the input files are not yet selected the open file dialog is opened, with the appropriate file
filters for the input and observation data, otherwise select the menu option File→ Open. The
actual sub-system is shown in the window title, see Figure 5.2.
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Figure 5.2: Overview of input and output files for sub-system Analysis

Below follows a summary of the ANALYSIS output files:

Print file <name.pra> output print file
Component file <name.cmp> output file with specific information about tidal

components
Hindcast file <name.hdc> output file with hindcast time-series
Residue file <name.res> output file with residual time-series
TEKAL file <name.tka> output file for graphical presentations

where name is the filename of the input file <∗.ina>.

Note: Be aware that the input files must satisfy the default extensions as defined for Analysis
input files. When this is not the case, please rename the files.

At any time the filenames of the selected input files and the names of the output files are
shown, as derived from the name of the input file <∗.ina>. See section 5.1.3 and Figure 5.2.

Press the button Start Analysis.

After starting the sub-system the progress will be displayed by the Progress Monitor, see
Figure 5.3. At the end of the run a report of the number of warnings and/or fatal errors is
shown. For an explanation of these warnings/errors, please browse your print file.
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Figure 5.3: Progress Monitor window for sub-system ANALYSIS

5.1.2 Input files

ANALYSIS needs input data from two files, the input data file and the file with observations.

As a result of a ANALYSIS computation the processed output files will contain the major
characteristics of the performed tidal analysis as well as the tidal station and tidal series itself.

The header lines are directly followed by the data. As the data are read free-formatted there
are no conditions with respect to the lay out of the data part of the file. The number of
observations per line (a line is a record) is free.

5.1.2.1 Input data file (<∗.ina>)

The input file format is described in section A.1 It is noted that this input data file is also used
to prepare a PREDICT input file by using the GUI of the prediction sub-system.

Remark:
� The input file <∗.ina> must have at east one line with the ’+’-sign.

5.1.2.2 File containing the observations (<∗.obs>)

The <∗.obs> file contains the observations that will be processed in ANALYSIS.

The unit of the observations (meter, centimetre, inches) is free. We advise to choose cen-
timetres as the unit for observations, since the number of printed decimal digits for the results
is fixed. So, for centimetres the printed results are actually more accurate.

Remark:
� Never use a ’+’ sign to indicate positive values. It is possible that the record containing

this value is identified as a header line. A value without a sign is identified as a positive
value.

ANALYSIS enables you to define sub-series for the tidal series on this file. This is important
if the series contains gaps or sections with unreliable data, see the description of the input
data file in section A.1. The parts between the sub-series, the so-called gaps, are excluded
from the computation. Be aware that there is no guarantee that your input specification au-
tomatically agrees with the sub-series itself. If start and end time for sub-series are specified
incorrectly, it may happen that the input specification for the sub-series is inconsistent with the
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sub-series of the data on the observations file. As a consequence of this, parts of the (unreli-
able) gaps will be involved in the harmonic analysis. In order to prevent this we strongly advise
to fill the gaps with unrealistic values, e.g. 99999, enabling the system to check whether parts
of gaps are involved in the harmonic analysis. (actually each value bigger than 1000 will sat-
isfy) Detection of these unrealistic values will cause the system to abort with an error-message
ERROR 21. See the list of messages, section D.1.

5.1.3 Output files

A harmonic analysis produces the following result files:

<∗.pra> output print file
<∗.cmp> output file with specific information about tidal components
<∗.hdc> output file with hindcast time-series
<∗.res> output file with residual time-series
<∗.tka> output file for graphical presentations

5.1.3.1 Print file (<∗.pra>)

The print file <∗.pra> starts with an exact echo of the input data file <∗.ina>. Depending
on the option chosen by you (see section 5.1.1), this is followed by an extensive Input Inter-
pretation Report. This part of the print file may contain error and/or warning messages. A
number of constraints, limits and relations are checked immediately after interpretation. The
warnings and errors may interrupt the print output. We strongly advise to scan the print file for
messages immediately after the computation has ended.

You may also find some error and/or warning messages as a result of a thorough checks on
the consistency of the set of input parameters, see section D.1.

Next, the print file continues with a printout of the date-time (from the input file) for the tidal
series H(1 : N), read from the observation file <∗.obs>, plus an echo of the number of
observations.

This is followed by the results. These are printed per instrument and sub-series. For each
instrument and sub-series a table is given with, for each tidal component, the astronomical
arguments V0 + u and F for the middle time point of the instrument or sub-series, as com-
puted by the system. This table (or these tables) is followed by a table of the computed tidal
amplitudes and phases for the selected set of components.

Notice that there may be a slight difference between the input date-time groups for instruments
and sub-series and the printed results. This results from the fact that the computational pro-
cess requires that the number of observations per instrument or sub-series is odd, which may
lead to disappearance of the last observation.

After the table with computed amplitudes and phases you find the computed parameters V V 1
and V V 2. They are a measure for the standard deviation of the analysis and are computed
in fully independent ways. These two parameters should be (almost) equal for all the printed
digits. That is a guarantee for an accurate numerical solution of the amplitudes and phases.
A difference in the last printed digit is allowed. When there is a significant difference between
V V 1 and V V 2 the matrix of normal equations will be added automatically to the print file
for a some insight in the numerical process. For most applications the numerical process is
sufficiently stable in that it will result in an accurate solution with V V 1 = V V 2. If there
is a significant difference between these two parameters, first check your input. There may
be errors or inconsistencies in the set of input parameters which will cause the difference
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between V V 1 and V V 2.

The standard deviation represents an estimate for the standard deviation of the residues, that
is, the difference of observation and hindcast over the period of analysis. It gives an indication
how well the hindcast fits the observed data.

Recapitulating, from V V 1 and V V 2 conclusions can be drawn about the numerical accuracy
of the solution in terms of the numerical solution method used. The standard deviation indi-
cates how well the mathematical model with the selected set of components fits the provided
data (observations).

If you choose the option that provides an accuracy analysis for the computed results a table of
estimated mean errors per tidal component (in terms of cosines and sines, see section 8.4.5)
will be printed. Ideally the mean errors should have roughly equal magnitude. Components
with strongly differing mean errors normally appear in pairs, indicating that the Rayleigh cri-
terion is violated so they could not be resolved independently. You should either apply astro-
nomical coupling of the two, or remove one of them, if coupling is not possible.

Depending on the options chosen, a table with results on the auto-correlation of the residues
is next. Ideally, the time-series of the residue will behave like white noise. From the statistical
parameters in this table conclusions can be drawn how well the frequency spectrum of the
residue corresponds to the ideal white noise.

The print file concludes with a report giving the dynamic memory usage, an error report and a
file-report. From the report on memory usage you can derive the memory words for dynamic
storage that were unused. This may be useful information when you are considering a rerun
with more components and/or more observations.

5.1.3.2 Component file (<∗.cmp>)

The component file<∗.cmp> starts with a copy of the "plus" header lines from the input data
file <∗.ina> and the observation file <∗.obs>, which serve as an identification of this file.

The component file <∗.cmp> consists of two blocks of results, one block with results per
instrument and the second block with information per sub-series. In the instruments block you
will find the time step and the mean level of the observations, which are computed for each
instrument separately. If computed (INFO(4) = 1), the linear trend for the instrument will
be added to this block. The block for sub-series contains one or more tables with the computed
amplitudes and phases as well as the applied astronomical arguments V0 + u and F . These
arguments hold for the middle time point of the series and consequently vary per sub-series.
Note that one single set of tidal amplitudes and phases is determined, independent of the
number of instruments or sub-series. For an explanation of these parameters we refer to the
general introduction in section 8.1.

Remark:
� The component file with extension CMP can also be used to prepare input files for the

Prediction sub-system by making use of the FileSelector (see section 5.1.1).
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5.1.3.3 Hindcast file (<∗.hdc>)

The hindcast file<∗.hdc> starts with a copy of the "plus" header lines from the input data file
<∗.ina> and the observation file <∗.obs>, which serve as an identification of this file.

Next, you will find the time-series of the computed hindcast. The hindcast is the time-series
computed on the basis of the tidal amplitudes and phases that have just been determined.
The time-series for the hindcast is computed for the same time period as the tidal series on
the <∗.obs> file is defined, so from date-time begin (TB) until date-time end (TE).

5.1.3.4 Residue file (<∗.res>)

The residue file <∗.res> starts with a copy of the "plus" header lines from the input data file
<∗.ina> and the observation file <∗.obs>, which serve as an identification of this file.

This header is followed by the time-series of the computed residues. The residues are defined
as observations minus hindcasts. The time period for the residues is the same as for the tidal
series from the <∗.obs> file, so from date-time begin (TB) until date-time end (TE).

5.1.3.5 Graphics data file (<∗.tka>)

The graphics file <∗.tka> starts with a copy of the "plus" header lines from the input data file
<∗.ina> and the observation file <∗.obs>, which serve as an identification of this file.

This file contains the time-series of time, hindcast, observation and residue in the format that
is needed for presentation using Delft3D-QUICKPLOT or GPP. The time-series on this file are
in original form or corrected for mean, depending on the choice for input parameter INFO(1).
You do not need any knowledge about the contents of this file: the formats are set according
to the requirements of the Delft3D-QUICKPLOT or GPP systems. Keep in mind that you need
this file if you want to do graphics.

5.1.4 Restrictions

In this section we give a complete list of the restrictions of ANALYSIS.

1 The period for harmonic analysis is restricted to 1950-2049.
2 Maximum number of instruments equals 10.
3 Maximum number of sub-series (for whole tidal series) equals 100.
4 Maximum number of components equals 234.
5 Maximum number of groups of coupled components equals 10.
6 Maximum number of sub-components per coupled group equals 10.
7 Minimum number of data per sub-series equals 3.
8 Minimum number of data per instrument equals 3.
9 Maximum memory allocation for dynamic storage equals 550 000 memory words.

5.2 PREDICT

The formula for astronomical tide prediction is:

H(t) = A0 +
k∑
i=1

AiFi cos (ωit+ (V0 + u)i −Gi) (5.1)

in which:

H(t) predicted water level at time t
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A0 mean water level
k number of relevant constituents
i index of a constituent
Ai local tidal amplitude of a constituent
Fi nodal amplitude factor
ωi angular velocity
(V0 + u)i astronomical argument
Gi improved kappa number (= local phase lag).

The values for A0, Ai and Gi for the selected constituents are input variables. The system
computes V0 + u and F for each constituent (for the period of prediction). Output is a time-
series H(t).

For a more detailed introduction, see section 8.1 and 8.5.

5.2.1 Running the system
Start Delft3D-TIDE, see chapter 3.

The User Interface will pop up. To set the sub-system to PREDICT:

Select Subsystem→ Predict→ GUI, see Figure 5.7.

Figure 5.4: Menu option Subsystem→ Predict→ GUI

The actual sub-system is shown as window title.

PREDICT operates in a file oriented way. That means that input files have to be prepared
before you can start the system successfully. You can prepare an input file either by editing
an already existing PREDICT input file ’by hand’ or — in the case predictions have to be
prepared with sets of tidal constants resulting from a former ANALYSIS run — by making
use of the built-in PREDICT GUI. On the basis of the data on the input file with required mask
<∗.inp> the computational process proceeds. After completion of the computation, a number
of output files have been produced. The print file <∗.prp> contains a complete report of the
computation and provides you with a good impression of the results. The PREDICT GUI may
be very useful while preparing a PREDICT input file on the basis of results of a former tidal
analysis with ANALYSIS.

Below follows a summary of the PREDICT output files:

<name.prp> output print file
<name.prd> output file with time-series of predicted values
<name.tkp> output file for graphical presentations

where <name> is the basename for the input file <name.inp>.
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Automatic input processing

In order to run PREDICT GUI first make this sub-system the active sub-system by selecting
option Predict from the Subsyst menu in the Main Menu.

The PREDICT GUI extracts necessary information from the pertaining <∗.ina> file and
<∗.cmp> file from ANALYSIS in order to create an input file for PREDICT. This sub-system
starts an interactive dialogue and is highly self-explanatory. You are led step by step through
the system; many pages of useful help texts will be shown on the screen.

For the preparation of an input file for PREDICT, some extra data are needed. The interactive
dialogue proceeds as follows:

� Specification of period for prediction
The time period for prediction can not be derived from a former analysis. You will be
prompted to enter this information.

� A set of tidal components (with local amplitudes and phases)
The block of tidal constituents from the <∗.cmp> file in ANALYSIS will be moved in the
correct format to the correct place in the input file for PREDICT.

� Determination of mean levels per sub-series
In PREDICT you have to split up the time-series for prediction in a number of sub-series,
each with its own mean level. From the individual mean levels as computed during tidal
analysis, one overall (average) mean level is computed for the whole time-series. For the
mean level in the prediction you may agree with the overall mean level as computed in
the GUI and shown on the screen. Reply to the prompt by RETURN if you agree with the
computed average; otherwise type in the desired mean level.

� Definition (start/end time) of sub-series
The system takes care of computing the correct length of the sub-series, taking into ac-
count that sub-series do not exceed the length of 1 month duration.

In the PREDICT GUI you can define a new unit for prediction. For example, the tidal analysis
was done in centimetres, but you prefer tidal prediction in meters. For the new unit, the sub-
system automatically computes the correct scaling for the tidal constituents. Available units
for water levels are centimetres, meters, inches and decimal feet (e.g. 4.1 feet). For velocities
corresponding units are available.

Prediction from available input file

In order to run PREDICT first make this sub-system the active sub-system by selecting option
Predict from the Subsyst menu in the Main Menu.

Note: Be aware that the input file should satisfy the default extension as defined for PREDICT
input files. If not, please rename the files.

At any time the filenames for the selected input files, can be read as displayed on the main
window. In addition the names of the output files are shown, as derived from the name of
the input file <∗.inp>, applying the default extensions for result files. See section 5.2.3 and
Figure 5.5.

After starting the sub-system the progress will be displayed by the Progress Monitor, see
Figure 5.6. At the end of the run a report of the number of warnings and/or fatal errors is
shown. For an explanation of these warnings/errors, please browse your print file.
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Figure 5.5: Overview of input and output files for sub-system PREDICT

Figure 5.6: Progress Monitor window for sub-system PREDICT
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5.2.2 Input files

In the cases that a prediction will be performed starting from the results of a former analysis
with ANALYSIS, the PREDICT GUI will take care of the format of the <∗.inp> file for PRE-
DICT. If you have to prepare an input file for PREDICT by yourself, it is necessary to know the
exact format of the <∗.inp> file, see section A.2 for the format description.

5.2.3 Output files

Computations with PREDICT result in three output files:

<name.prp> output print file
<name.prd> output file with predictions
<name.tkp> output for graphical presentations

5.2.3.1 Print file (<∗.prp>)

The print file starts with an exact copy of the input from the input data file, described in the
previous section. Depending on the option chosen by you (see section 5.2.1), this is followed
by an Input Interpretation Report. This contains an interpretation of the parameters from
the input file <∗.inp>. Some times this print-out may be interrupted by error messages,
for example, when built-in restrictions of the software are violated or when the set of input
parameters is internally inconsistent.

The print file will continue with the computed time frames for the sub-series. This is followed
by the presentation of the results per sub-series. For each sub-series a table of the computed
astronomical arguments V0 + u and the nodal factor Fi for the given set of components is
printed, all relative to the middle time point of the sub-series. This is followed by the computed
time-series for the prediction for that sub-series. The print file ends with a table of computed
minima and maxima per sub-series.

5.2.3.2 Predict file (<∗.prd>)

The PREDICT output file <∗.prd> starts with an exact copy of the "plus" header lines from
your input data file to identify the data set. This is followed by the predicted values, 6 values
per record line, without any interruption. The transition points of sub-series are not recognis-
able.

5.2.3.3 TEKAL file (<∗.tkp>)

The TEKAL output file <∗.tkp> starts with an exact copy of the "plus" header lines from your
input data file to identify the data set. Next, this output file contains the time-series of time and
predicted values in the format needed for presentation on a plotter or on the screen. This data
file is required for doing graphics. The predicted time-series on this file is always in original
form, so without correction for mean value.
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5.2.4 Restrictions

Below, a list of restrictions of PREDICT is given.

1 The period of prediction is restricted to period 1-1-1950 – 31-12-2049.
2 Maximum number of components equals 234.
3 Maximum number of sub-series equals 100.
4 Maximum number of values to be predicted equals 530 000, i.e. a prediction of one year

with a time interval of one minue is possible (530 000 > 366× 24× 60).

There is no explicit restriction on the length of the time period for which predictions can be
made in one computation (apart from the first restriction). If the Prediction GUI is used,
however, the length of the period to predict is limited to 100 months (100 sub-series of 1
month).

5.3 HILOW

For convenience we refer to the introduction on Tide Tables, see section 8.6.

5.3.1 Running the system
Start Delft3D-TIDE, see Chapter 3.

The User Interface will pop up. To set the sub-system to HILOW:

Select Subsystem→ High/Low→ GUI, see Figure 5.7.

Figure 5.7: Menu option Subsystem→ High/Low→ GUI

The actual sub-system is shown as window title.

Like the other sub-systems, HILOW operates in a file oriented way. That means that input
files have to be prepared before you can start the system successfully. You can prepare an
input file either by editing an already existing HILOW input file ’by hand’ or — in the case
tide tables have to be prepared with results of a former ANALYSIS or PREDICT run — by
making use of the built-in HILOW GUI, see section 5.3.1.1. On the basis of the data on the
input files the computational process is started. At completion one single output (print) file
has been created. Besides the actual results, this output file can provide you with a complete
interpretation of the input (Input Interpretation Report), if needed. For filename conventions,
see Appendix C.

For HILOW the following file extensions are defined:

<∗.obs> observed time-series on which tide tables are made
<∗.hdc> hindcast time-series on which tide tables are made
<∗.prd> predicted time-series on which tide tables are made
<∗.inh> input file with computation parameters
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<∗.prh> output print file with input report
<∗.hlw> output print file with tide tables

You can choose from the following options:

1 Automatic input processing
2 HILOW from available input file

5.3.1.1 Automatic input processing

The HILOW GUI may be very useful while preparing a HILOW input file from the results of a
former tidal analysis or from the results of a former tidal prediction.

In order to run the HILOW GUI first make this sub-system the active sub-system by selecting
option Subsystem→ High/Low→ GUI from the menu bar.

The GUI can operate in two modes, either from an input file from ANALYSIS or an input file
from PREDICT. The HILOW GUI extracts necessary information from the <∗.ina> file or the
<∗.inp> file from a PREDICT run in order to create an input file for HILOW.

For loading the input file, select File→ Open from the menu bar. A file selection window pops
up from which the input file is selected.

Note: The operation mode of High/Low is dependent on the file extension, either <∗.ina>
or <∗.inp>.

To start the High/Low GUI subsystem press the button Start High/Low GUI.

The sub-system starts an interactive dialogue and is highly self-explanatory. You are led step
by step through the system.

The sub-system can operate in two modes:

1 Using ANALYSIS files for generating hilow-tables for <∗.obs> files or <∗.hdc> (obs =
observed and hdc = hindcast)
The HILOW input file is a copy of the ANALYSIS input file. As extra the first file needs to be
extended with block filter parameters in order to remove the non-astronomical extremes
from the tidal series. The HILOW GUI screens whether or not in the supplied <∗.ina>
file (from tidal analysis) the block filter parameters are present. If not, the block filter
parameters can be selected from a menu. Defaults can be selected by RETURN. Input by
you is validated for the legal range. The selected block filter parameters are added on the
newly created input file for HILOW.

2 Using PREDICT files for generating HILOW-tables for <∗.prd>-files (= predict files)
The HILOW input file will be generated starting from a PREDICT input file. At the end
the needed block filter parameters are asked for (see above). Since the predicted time-
series is purely determined by the supplied tidal constituents, resulting in a smooth be-
haviour, you are advised to select for the block filter parameters the indicated defaults
(press RETURN).
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Figure 5.8: Overview of input and output files for sub-system HILOW

5.3.1.2 HILOW from available input file

HILOW needs input data from two files, the input data file <∗.inh> and the file with the time-
series to be processed for high/low water computations; <∗.obs>, <∗.hdc> or <∗.prd>.

In order to run HILOW first make this sub-system the active sub-system by selecting option
Subsystem→ High/Low→ Calculation from the menu bar. The required input files should
be loaded from the File→ Open menu.

Note: Be aware that the input files should satisfy the default extension as defined for HILOW
input files. If not, please rename the files.

The selected filenames are listed in the TIDE - High/Low water window. The names of the
output files are shown, as derived from the name of the input file<∗.inh>, applying the default
extensions for result files. See section 5.3.3 and Figure 5.8.

By pressing the button Start High/Low the subsystem will start. After starting the subsystem
the progress will be displayed by the Progress Monitor, see Figure 5.9. At the end of the
run report the number of warning and/or fatal errors is shown. For an explanation of these
warnings/errors, please browse your print file.

5.3.2 Input files

The format for the observation time-series file <∗.obs> is described in section A.1 and for
the input file <∗.inh> is described in section A.3.
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Figure 5.9: Progress Monitor window for sub-system HILOW

5.3.2.1 Time-series files <∗.obs>, <∗.prd> or <∗.hdc>

This file contains the time-series for which the Tide Tables will be made, executing HILOW.
Usually high/low water tables are generated for

� observations (e.g. as analysed in ANALYSIS)
� hindcasts (e.g. an output series of ANALYSIS)
� predicted time-series (e.g. an output series of PREDICT)

These data-files contain the time-series that will be processed in HILOW.

5.3.2.2 Input data file (<∗.inh>)

In this section we discuss the data on the input data file of HILOW.

The input file for HILOW is identical to the input file of ANALYSIS. It is therefore possible to
use the same input file for both the ANALYSIS and the HILOW computation. The header lines
of the input file of ANALYSIS, however, may contain specific information about that ANALYSIS
run. It is therefore advised to use the HILOW GUI to copy the input file of an ANALYSIS
run to the input file of a HILOW run, because during the input processing a step is included
to change the header lines in the input file from specific ANALYSIS information to specific
HILOW information. For a description of the HILOW input file see section A.3.

5.3.3 Output files

There are two output files, one output print file, <∗.prh>, containing the Input Report fol-
lowed by some computational results and a second print file with the computed Tide Tables,
<∗.hlw>. Notice that the second file is also a print file.

5.3.3.1 Print file (<∗.prh>)

At each new print page, the "plus" header lines from the<∗.inh> file and<∗.obs>,<∗.hdc>,
<∗.prd> file are inserted for identification.

The print file <∗.prh> first gives an exact echo of the input data file. Next, the Input Interpre-
tation Report is printed. This part may be interrupted by error messages, for example when
built-in limitations of the software are violated, or if the set of input parameters is inconsistent.
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5.3.3.2 Tide table file (<∗.hlw>)

At each new print page, the "plus" header lines from the<∗.inh> file and<∗.obs>,<∗.hdc>
or <∗.prd> file are inserted for identification.

Finally the computed tide tables are printed,<∗.hlw>. These have the form of well-structured
tables for times and values of High Waters (HW) and Low Waters (LW). Next to the dates, a
number is printed. This equals the number of hours elapsed until 0:00 hours that day. Each
year at 1 January 0:00 hours this value is reset to zero.

5.3.4 Restrictions

HILOW is subject to five restrictions. Here, restrictions are only listed for the relevant input
data on the input data file.

1 The time-series must lie between 1 January 1950 and 31 December 2049.
2 The maximum number of data in the processed time-series equals 18 000 (Nobs≤ 18 000).

Note: that processing one full year of half-hourly data (2*8 760/2*8 784 values), or a half
year of 15 minute data, does not pose any problems.

3 The maximum number of instruments equals 10.
4 The maximum number of sub-series equals 10.

Remark:
� Restrictions 5 to 9 of section 5.1.4, ANALYSIS, also apply. When preparing an input file

specifically for the HILOW computation or using the HILOW GUI, you will not confront
these restrictions (no coupling, 1 component only, no very short sub-series).

5.4 ASCON

The present sub-system calculates the frequencies and the time dependent astronomical
arguments V0 + u and F for any or all of the 234 internally available constituents and for any
number of date-time groups. The calculations are based on the Schureman-formulae, with
T = 0 equal to 1 January 1900, 00:00 GMT. For a definition and explanation of these factors
and their use in the tidal formula, you are referred to section 8.1.

Remark:
� ASCON is a standalone sub-system. It is also incorporated in ANALYSIS and PREDICT,

where the same quantities are needed.

5.4.1 Running the system
� Start Delft3D-TIDE, see Chapter 3.

The User Interface will pop up. Like the other sub-systems, ASCON operates in a file oriented
way. That means that you have to prepare your (single) input file before you can start the
system successfully. To set the sub-system to ASCON

Select Subsystem→ Ascon from the menu bar, see Figure 5.10.
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Figure 5.10: Subsytem→ Ascon selected

If the input files are not yet selected the open file dialog is opened, with the appropriate file
filter for the input file, otherwise select the menu option File→ Open. The actual sub-system
is shown as window title.

On the basis of the data on the input files the computational process is started . At completion
one single output (print) file has been created. For filename conventions, see Appendix C.

For ASCON the following extensions are defined:

<∗.inc> input file with date-time groups.
<∗.prc> output print file with astronomical arguments.

ASCON needs input data from the input file<∗.inc> only. Here we expect this input file to be
ready for use.

Be aware that the input file should satisfy the default extension as defined for ASCON input
files. If not, please rename the files.

At any time the filenames for the selected input files, can be read from the File Report as
displayed on the lower half of the screen. In addition the names of the output files are shown,
as derived from the name of the input file <∗.inc>, applying the default extensions for result
files. See Appendix C and Figure 5.11.

After starting the sub-system the progress will be displayed by the Progress Monitor, see
Figure 5.12. At the end of the run areport of the number of warnings and/or fatal errors is
shown. For an explanation of these warnings/errors, please browse your print file.

5.4.2 Input files

A description of the ASCON input file is given in section A.4.

5.4.3 Output file

Only one output (print) file is produced, <∗.prc>.
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Figure 5.11: Overview of input and output files for subsystem ASCON

Figure 5.12: Progress Monitor window for sub-system ASCON
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Print file (<∗.prc>)

The print file, <∗.prc>, for ASCON starts with an echo of the "plus" header lines of the input
file, discussed in section A.4.

Next, a (series of) table(s) follows which present the astronomical arguments V0 + u and F
as well as the angular frequency for the selected set of components. The quantity V0 + u is
defined with respect to Greenwich (V0 is the astronomical phase for the Greenwich meridian).
For an explanation of V0 + u and F , see section 8.1.

5.4.4 Restrictions

ASCON is subject to two restrictions

1 The date-time groups must lie between 1 January 1950 and 31 December 2049.
2 The set of components is limited to the 234 internally available components.

5.5 FOURIER

FOURIER incorporates a rather straight-forward Fourier analysis of time-series. Within a
Delft3D-TIDE environment the major application of this sub-system lies in the Fourier analysis
of time-series of residuals as they result from a tidal analysis by ANALYSIS. The location of the
peaks in the Fourier spectrum give information where tidal constituents may be missing. By
absence of relevant information about the major tidal constituents, FOURIER may be useful
when applied on observational time-series to obtain a global impression with respect to the
major tidal constituents.

The TIDE package offers two methods for Fourier analysis:

1 Sub-system FOUR: Standard Fourier Transform (SFT)
2 Sub-system FFT: Fast Fourier Transform (FFT)

5.5.1 Standard Fourier Transform (SFT)

In FOURIER based on standard Fourier analysis the evaluation of the Fourier spectrum is
done by a numerical approximation of the Fourier integrals. Drawback of this method is it’s
poor performance for long time-series, since the computing time is proportional to the square
of the number of data. Therefore the practical application of this method is restricted to time-
series of some hundreds of involved data. Although the original time-series may be much
longer, the sub-system features the selection of a sub-series (see below).

FOUR features:

a. Selection of sub-series F (n1 : n2) as part of the read-in time-series F (1 : n).
b. Restriction of Fourier spectrum to relevant tidal bands.
c. Restriction of the Fourier spectrum S(0 : wmax ) to the sub spectrum S(w1 : w2).

Dealing with long time-series, options above may result in a considerable speed-up of the
computational process.

Note: Nowadays computer performance for FOURIER transformation is not a issue any
more. E.g. option a) wit a period of 355 or 369 days can be combined with option c) with
S(0◦ : 180◦) assuming ∆t = 1h.
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Ad a. Selection of sub-series F (n1 : n2) [synodic periods]

From the read-in time-series F (1 : n) a relevant part F (n1 : n2) may be selected for Fourier
analysis. You will be prompted for adequate values for n1 and n2. FOURIER supports the
selection of synodic periods. In the field of tidal analysis a time interval will be referred to as
a synodic period if it encloses multiples of the major tidal periods, so the periods of the major
tidal constituents. FOURIER includes following synodic periods: 15.0, 29.5, 30.0, 355.0 and
369.0 days.

For the Fourier analysis of time-series of residuals it’s preferable to take the length of the
period for analysis (almost) equal to a synodic period. The reason for this is that, as easily can
be derived, for a synodic period the Fourier spectrum will contain the major tidal frequencies.
After the selection of the start of the time-series (= n1) the system automatically proceeds
with the computation of the relevant synodic periods. After this the resulting values for n2 will
pop up in a menu, supporting you by the selection of a relevant synodic period.

Ad b. Tidal bands

The computation of the Fourier spectrum may be restricted to one or more tidal bands, ranging
from tidal band 0 to 12. In the field of tidal analysis a tidal band contains the tidal constituents
with the same diurnality. e.g. tidal band 2 contains the tidal constituents ’occurring’ approx-
imately twice a 24 hour’s day, with M2 as the most well-known constituent. Tidal band 0
contains the long-periodical constituents. As mentioned the restriction of the Fourier analysis
to tidal bands may result in a considerable speed-up of the computational process.

Ad c. Sub spectrum S(w1 : w2)

Here the computation of the Fourier spectrum may be restricted to a part of the frequency
band, from frequency w1 until w2. Frequencies w1 and w2 are to be input by you.

Of course the maximum frequencies should not exceed the so-called Nyquist frequency, de-
fined as:

fNyquist =
180

∆t
[degrees/hour]

E.g. for a time step of ∆t = 1 hour the Nyquist frequency = 180 degrees/hour.

5.5.2 Fast Fourier Transform (FFT)

The Fast Fourier Transform features it’s superior computational speed. Especially for long
time-series (many thousands of time steps) the Fast Fourier Method may be very useful. The
implemented FFT method is the so-called Markel and Ritea method.This method expects the
number of data to be a power of two. If the number of data on the user-provided data set
is not a power of two, the time-series will be extended by adding zeroes, until the number of
data equals the next power of two. From the definition of the Fourier Transform it is easy to
see that adding zeroes will not affect the resulting Fourier spectrum. It will only increase the
spectral density, resulting in more frequencies per unit.

FFT only features the selection of sub-series F (n1 : n2), see above. The definition of
the computational Fast Fourier Transform does not allow the selection of tidal bands or sub
spectra. At the other hand the Fast Fourier Transform is that fast, that this speed-increasing
options are hardly needed.
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Figure 5.13: Menu Subsystem→ Fourier→ Fourier SFT

5.5.3 Running the system

Slightly different from the other sub-systems, FOURIER does not expect the input parameters
to be present on a file.

Here the input parameters like time step, options etc. should be entered in an interactive
dialogue.

At completion next output files will be created for Standard Fourier Transform:

<name.prf> output print file for SFT
<name.tkf> output file for graphical presentations for SFT

For Fast Fourier Transform output files below will be created:

<name.prt> output print file for FFT
<name.tkt> output file for graphical presentations for FFT

Start Delft3D-TIDE, see Chapter 3.

The User Interface will pop up. In order to run FOURIER first make this sub-system the active
sub-system by selecting option Fourier from the Subsystem menu in the Main Menu, see
Figure 5.13.

At any time the filenames for the selected input files, can be read from the File Report as
displayed on the lower half of the screen. In addition the names of the output files are shown,
as derived from the name of the input file, applying the default extensions for result files.

The time-series for Fourier analysis will be read from an external data set.

The format of this data set should be like the well-known TIDE-format of the <∗.res> files
from ANALYSIS.

5.5.4 Restrictions

FOURIER is subject to one restriction.

1 Number of time-series: n ≤ 550 000.
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6 Graphics

ANALYSIS, PREDICT and both FOURIER sub-systems create column oriented TEKAL data
files, <∗.tka> and <∗.tkp> files. As these files contain an appropriate header for the
Delft3D-QUICKPLOT and GPP graphics programs, these files can easily be processed by
Delft3D-QUICKPLOT and GPP.

Delft3D-QUICKPLOT and GPP may be activated from the Delft3D-MENU. Select Utilities in
the main window, next QUICKPLOT or GPP.

From the TEKAL data files of ANALYSIS time-series can be plotted of observations, hindcast
and residuals. From the TEKAL data files from PREDICT the time-series of the tidal prediction
can be plotted. From the TEKAL data files of FOURIER the spectral series can be plotted of
the residuals. For the application of Delft3D-QUICKPLOT and GPP, we refer to the respective
User Manuals (QUICKPLOT UM, 2013; GPP UM, 2013).
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7 Tutorial

For each of the subsystems are tutorials given. These examples are part of the tutorials as
distributed with Delft3D.

7.1 ANALYSIS

For the ANALYSIS subsystem 4 examples are given.

7.1.1 Example 1

Tidal Station Hook of Holland
Location Coastal station North Sea
Period year 1980, month of April
Number of components 37
Number of coupling groups 3
Number of instruments 1
Number of sub-series 1
Trend/ linear variation no
Accuracy analysis no
Graphics file no

Remarks:
� The dataset with the observations contains hourly data for all of 1980. Only the data for

the month of April are used in the tidal analysis.
� The print file of this example contains a number of warning for the violation of the

Rayleigh criterion. This example represents the situation that there are constituents
which are formally too close in frequency (∆ω = 0.4715, requiring an observation
length of 360/(24×0.4711) = 31.9 days). You should either apply astronomical cou-
pling (see section 8.3.4 ), or drop one of the two constituents. Given the nature of the
least squares solution method, however, a 90 % satisfaction of the Rayleigh criterion
is almost always acceptable. This is the example here. If the computation is redone
with observation length 32 days or more, the Rayleigh criterion is formally satisfied (no
warnings). In the present example, the results will be practically the same.

7.1.2 Example 2

Tidal Station Hook of Holland
Location Coastal station North Sea
Period full year 1980
Number of components 60
Number of coupling groups 0
Number of instruments 1
Number of sub-series 1
Trend/linear variation no
Accuracy analysis no
Graphics file yes; with correction for mean level

Remark:
� The hindcast file <anaex2.hdc> will be used for HILOW Example 7.3.2.
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7.1.3 Example 3

Tidal Station Centre Point of the Bermuda Triangle
Period 1 – 30 June 1989
Number of components 29
Number of coupling groups 3
Number of instruments 2
Number of sub-series 1
Trend/ linear variation yes
Accuracy analysis yes
Graphics file yes; without correction for mean level

Remarks:
� See the second remark of Example 7.1.1.
� The residuals <anaex3.res> will be used for FOURIER Example 7.3.1

7.1.4 Example 4

Tidal Station Atlantis (Lost Continent)
Location Atlantic Ocean
Period Full year 2024
Number of components 38
Number of coupling groups 0
Number of instruments 2
Number of sub-series 6
Trend/ linear variation no
Accuracy analysis no
Graphics file no

Remark:
� See the second remark of Example 7.1.1. Formal satisfaction of the Rayleigh Criterion

requires an observation length of 365 days ( 360/(24×0.0411) = 365). In the present
observation series the month of January is not present which reduces the length to 334
days (∆ω = 360/(24× 334) = 0.0449).

7.2 PREDICT

For the PREDICT subsystem 2 examples are given.

7.2.1 Example 1

Tidal Station Atlantis (Lost Continent)
Location Atlantic Ocean
Period 1 - 30 June 2027
Time step 30 minutes
Number of components 38
Number of sub-series 1

Remark:
� The prediction file <prdex1.prd> will be used for HILOW Example 7.3.1.

44 of 100 Deltares



DRAF
T

Tutorial

7.2.2 Example 2

Tidal Station Hook of Holland
Location Coastal station North Sea
Period 1999 November 1 until 2000 February 29
Time step 60 minutes
Number of components 60
Number of sub-series 4

7.3 HILOW

For the HILOW subsystem 3 examples are given.

7.3.1 Example 1

Input time-series Atlantis (Lost Continent); prediction
Location Atlantic Ocean
Period 1 – 30 June 2027
Time step 30 minutes

Remark:
� The prediction file <prdex1.prd> comes from PREDICT Example 7.2.1 .

7.3.2 Example 2

Input time-series Hook of Holland; hindcast
Location Coastal station North Sea
Period Full year 1980
Time step 60 minutes

Remarks:
� It is noted once again that the HILOW input file is equal to the ANALYSIS input file: if an

analysis has been performed, the same input file can be used for tide tables of either
the observed or the hindcast series.

� Although the full year is available, the input file is prepared to generate the tables of
High and Low water for the month of April only. This is comparable to the ANALYSIS
Example.

� The hindcast file <anaex2.hdc> comes from ANALYSIS Example 7.1.2.

7.3.3 Example 3

Input time-series Centre Point Bermuda Triangle; observed water level
series

Period 1 – 30 June 1989.
Time step 60 minutes

Remark:
� This is the observation series analysed in ANALYSIS Example 7.1.3.

7.4 ASCON

For the ASCON subsystem 2 examples are given.

Deltares 45 of 100



DRAF
T

Delft3D-TIDE, User Manual

7.4.1 Example 1

Tidal Station Centre Point of the Bermuda Triangle
Number of components 29
Astronomical arguments for the
following Date-Time groups

1999, January 1 , 00:00:00 GMT
2000, January 1 , 00:00:00 GMT
2001, January 1 , 00:00:00 GMT

7.4.2 Example 2

Tidal Station Hook of Holland
Location Coastal station North Sea
Number of components 60
Astronomical arguments for the
following Date-Time group

2049, December 31, 00:00:00 GMT

7.5 FOURIER

For the FOURIER subsystem 3 examples are given.

7.5.1 Example 1

Tidal Station Centre Point of the Bermuda Triangle
Character of the data Residue file from example 3 of analysis
Length of generated time-series 30.0 days
Length of analysed time-series 29.5 days from start (=suitable period)
Fourier option tidal bands 0, 2, 4, 6 and 8

The examples 7.5.2 and 7.5.3 are related to artificial time-series for an adequate test of the
Standard Fourier Transform and the Fast Fourier Transform.

The generic formulae for the artificial time-series reads:

F (t) =
n∑
i=1

Ai cos(ωit)

7.5.2 Example 2

Character of the data Artificial
Parameters in generic formulae ω1 = 15.5 degr/h, A1 = 10 cm

ω2 = 16.5 degr/h, A2 = 20 cm
ω3 = 28.5 degr/h, A3 = 30 cm

Length of generated time-series 30 days (=720 data points)
Length of analysed time-series 30 days (=720 data points)
Time step (minutes) 60 minutes
Applied Fourier Method Standard Fourier Method
Fourier option full spectrum analysis
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7.5.3 Example 3

Character of the data Artificial
Parameters in generic formulae ω1 = 21.97 degr/h, A1 = 10 cm

ω2 = 43.94 degr/h, A2 = 20 cm
ω3 = 109.86 degr/h, A3 = 30 cm

Length of generated time-series 682.67 days (=16384 data points)
Length of analysed time-series 682.67 days (=16384 data points)
Time step (minutes) 60 minutes
Applied Fourier Method Fast Fourier Transform
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8 Conceptual description

8.1 Mathematical representation of the tide

The astronomical tide observed in oceans and seas is directly or indirectly the result of grav-
itational forces acting between the sun, moon, and earth. The influence of other celestial
bodies is negligibly small.

The most important motions for the tide are the earth’s rotation around its axis (1 day), the
moon’s orbit around the earth (27.32 days), and the earth’s orbit around the sun (365.25
days).

The observed tidal motion can be described in terms of a series of simple harmonic con-
stituent motions, each with its own characteristic frequency ω (angular velocity). The ampli-
tudes A and phases G of the constituents vary with the positions where the tide is observed.

In this representation by means of the primary constituents, compound and higher harmonic
constituents may have to be added. This is the case in shallow water areas for example.
where advection, large amplitude to depth ratio, and bottom friction give rise to non-linear
interactions. For a list of primary and compound constituents, see Appendix B.

The general formula for the astronomical tide is:

H(t) = A0 +
k∑
i=1

AiFi cos (ωit+ (V0 + u)i −Gi) (8.1)

in which:

H(t) water level at time t
A0 mean water level over a certain period
k number of relevant constituents
i index of a constituent
Ai local tidal amplitude of a constituent
Fi nodal amplitude factor
ωi angular velocity
(V0 + u)i astronomical argument
Gi improved kappa number (= local phase lag)

F and (V0 +u) are time-dependent factors which, together with ω, can easily be calculated
and are generally tabulated in the various tidal year books. V0 is the phase correction factor
which relates the local time frame of the observations to an internationally agreed celestial
time frame. V0 is frequency dependent. F and u are slowly varying amplitude and phase
corrections and are also frequency dependent. For most frequencies they have a cyclic period
of 18.6 years. A0, Ai and Gi are position-dependent: they represent the local character of
the tide.

If for a specific location A0, Ai and Gi are known, the above formula can be used to predict
the local water level H(t) at any time.

Conversely, if at a location a series of tidal observations W (tj) is known, the above formula
can be used in a least squares analysis to estimate the constants A0, Ai and Gi.
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8.2 Tidal current

The tidal current (horizontal tide) and the water level (vertical tide) are two appearances of
the same tidal phenomenon. The local behaviour of the current components can also be
described in terms of a series of simple harmonic constituents. So, Equation (8.1) holds also
for currents, with generally the same constituents (same ω, frequency), but with its own values
for A0, Ai and Gi.

Tidal analysis of current component registrations is analogous to analysis of water level ob-
servations. With A0, Ai and Gi known for the components of a current vector, a prediction of
the tidal current can again be made for any given period in the past or future.

Remarks:
� In the remainder of this User Manual only water levels are mentioned. All sub-systems

and all theory apply equally well to the scalar components of current observa-
tions. Since the (tidal) current is a vector quantity, you must first split it into orthogonal
components, e.g. North and East current components.

� These scalars can then be treated just as water levels. This holds for all concepts in this
manual: tidal analysis, sets of components, tidal prediction, tables of times and values
of tidal current extremes, graphics, etc.

8.3 Tidal analysis

8.3.1 Mathematical model

Starting from a series of e.g. hourly or half-hourly tidal height registrations W (tj), ANALYSIS
can be used to determine the constants A0, Ai and Gi. On the basis of one month of data a
good characterisation of the tide can already by given. A drawback of such short series is the
fact that not all important tidal constituents (tidal components) can be resolved independently.
With observations of longer duration, such as one year, also longer period constituents and
various small constituents can be determined explicitly and independently.

A key part of the analysis is the proper selection of the set of constituents which is assumed
to give a proper representation of the tide. Equation (8.1) with the set of assumedly important
tidal constituents forms the mathematical model of the tide that you prescribe. Knowledge
and information about the nature of the local tide, together with the sampling rate and duration
of the observations are essential in order to develop a good mathematical model.

As a result of non-resolvable very long period constituents or non-astronomical phenomena
such as wind, the mean water level may vary slowly. Also, the position of the registration
instrument may gradually change. To take account of such motions, if present, you may
include an extra term Bt to the analysis formula Equation (8.1), representing a trend.

In the case that the model is formulated in terms of k relevant constituents, a total of (2k+1)
unknownsA0,Ai andGi must be determined (or (2k+2) unknowns, ifBt is included). This
is realised by minimisation of the quantity:∑

j

(W (tj)−H(tj))
2 , (8.2)

using a least squares technique.

We have now — partly implicitly — touched upon four essential aspects of the formulation of
the mathematical model that require further attention:

1 the measurement interval (Nyquist condition)
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2 the total duration of the registration (Rayleigh Criterion)
3 astronomical coupling of constituents
4 the least squares solution technique

8.3.2 Nyquist condition (measurement interval)

In section 8.1 the general formula for the astronomical tide is given (Equation (8.1)). The tide
is prescribed as the sum of a series of single harmonic functions, each with its own frequency,
local amplitude and local phase (lag) or improved kappa number. The tidal frequencies that
are present in the tidal observation fix the frequencies in the tidal model.

The mathematical model requires that the measurement interval (Wt) is at most half the
smallest wave period (Tmin) that is present in the signal. This is called the Nyquist criterion:

∆t ≤ 1

2
Tmin (8.3)

In the oceans and in coastal seas the discernable tidal frequencies are generally smaller than
180◦/hour. This means that they correspond to wave periods that are larger than 120 minutes.
So, a measurement interval of W (t) = 60 minutes (1 hour) will satisfy.

In complicated river and estuarine situations much higher frequencies may occur. The water
level in the Gironde river in France is characterised by periodic fluctuations with frequencies
of 720 degrees per hour, which are of tidal origin. These frequencies correspond to wave
periods of 30 minutes, requiring a tidal measurement interval of 15 minutes or less.

In practice, the absence of tidal energy at the 12th-diurnal band, with frequencies roughly
180◦/hour (see Appendix B), forms a guarantee that a measurement interval of 60 minutes is
satisfactory.

8.3.3 Rayleigh criterion

The duration of a tidal observation — generally called the observation "length" — will vary
from case to case. This means that the resolvability of independent constituents, each having
its own fixed frequency, varies from situation to situation as well:

"In order to be able to resolve all constituents accurately, their frequencies must differ from
one another by at least:

∆ω =
360◦

T
(8.4)

in which T is the duration of the observation in hours".

This criterion is known as the Rayleigh criterion.

∆ω is also the smallest Fourier frequency component that can be resolved for a given time-
series.

In practice the observation length is given and cannot easily be changed. The Rayleigh cri-
terion then restricts the number of constituents that can be prescribed independently. For
example, with a 30 days registration, the Rayleigh criterion requires:

∆ω =
360

30× 24
=

360

720
= 0.5 (8.5)
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Similarly, registrations of 180 and 360 days duration lead to a Rayleigh criterion of 0.08333
and 0.04166 degrees per hour, respectively.

Appendix B lists all available tidal constituents and their frequencies in order of increasing
frequencies. It is clear that in most tidal analysis computations the Rayleigh criterion will
drastically restrict the choice of constituents that can be included.

8.3.4 Astronomical coupling

Very often a tidal registration series has a length of only one month. In many waters, however,
a proper description of the tide requires the inclusion of tidal constituents that can only be
resolved from half a year or a year of data. Simple inclusion of these components in the
mathematical model of the local tide will imply a violation of the Rayleigh criterion and lead to
unreliable results.

In the Delft3D-TIDE system you may resolve the related constituents in a coupled sense. Let
us assume the situation of one main component and several sub-components which are too
close in the frequency domain. You must prescribe the amplitude and phase relations
between the two or more constituents involved. In the numerical solution one "lumped" con-
stituent is resolved. Afterwards, the prescribed relations are applied again to determine the
separate amplitudes and phases. We note that this system presupposes that the main com-
ponent is essentially larger than the sub-components.

H(t) = A0 +
k∑
i=1

AiFi cos (ωit+ (V0 + u)i −Gi) (8.6)

i 6= υξ, . . . , υξ + λξ
ξ = 1, 2, ....., τ

H(t) = A0 +
τ∑
ξ=1

AυξFυξ cos
(
ωυξt+ (V0 + u)υξ −Gυξ

)
(8.7)

where:

τ number of groups of astronomically coupled constituents.
ξ sequence number of the group.
λξ number of sub-components in group ξ, solved together with the main compo-

nent of group ξ.
υξ index; 1 ≤ υξ ≤ λξ.

Appendix B gives a list of the astronomical couplings that may have to be made in case of
short observation series. Well known are the couplings (K1, P1), (N2, NU2), and (S2, K2). In
practice you should always try to use amplitude and phase relations based on a long period
analysis of a neighbouring station. Only if such information is not available, you may resort to
equilibrium tide relations given in Appendix B (amplitude relation is prescribed, phase relation
is equal to zero).

Remarks:
� You should always resolve the constituents of these three groups independently, if the

series is sufficiently long. It is strongly advised not to perform an analysis on a series
that is shorter than 30 days, e.g. 15 days. In such an analysis too many constituents
have to be coupled, which makes the mathematical model too rigid.

� The best results are obtained with observation periods corresponding to the so-called
synodic periods of one month, six months, and one year.
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8.3.5 Least squares solution technique

Assuming the choice of the mathematical model for the tide fixed (k constituents, a mean A0

and a linear trendB0), the model is numerically solved by means of a least squares technique.
This is based on the minimisation of the quantity:

N∑
i=1

(W (ti)−H(ti))
2 , (8.8)

where N is the number of observations, and W (ti) is the value of the observation at ti.
The solution involves a linear system of (2k + 1) or (2k + 2) equations, solved by LU-
decomposition. For good resolution, N should be much larger than (2k + 2). This is one of
the reasons why you should try to minimise the number of constituents that enter in the tidal
model. That is also directly in line with the aim of tidal analysis:

"extracting the local amplitudes and local phases of those constituents, that together give a
good description of the deterministic tidal part of an observation".

8.4 Special features

8.4.1 Trends

As a result of non-resolvable very long period constituents or non-astronomic phenomena
such as wind, the mean water level may vary slowly. Also, the position of the registration
instrument may gradually change. To take into account of such motions, if present, you may
include an extra term B0t to the analysis formula Equation (8.1), representing a trend.

8.4.2 Astronomically coupled constituents

Depending on the duration of the registration there may be constituents with a difference
in frequency that is too small for proper resolution of both constituents. In these cases the
smallest is linked to a corresponding main constituent and solved implicitly as part of this main
constituent. Afterwards the two constituents are decomposed using astronomical relations or
nearby information about the relative importance of the two. For a detailed description, see
section 8.3.4 above.

8.4.3 Registration gaps or unreliable data parts (sub-series)

In case of failure of the recording instrument, or otherwise partly unreliable data, sub-series
are defined, which are separated by gaps. These gaps cover the time periods of the unreliable
data. With separate values for F and (V0 + u) per sub-series, A0, B0, Ai and Gi are
determined excluding the gaps.

8.4.4 Multiple instruments

A special case arises if for the registration more than one instrument is used in succession.
The instrument sub-series, which my have different sampling intervals, are separated by non-
zero or zero length gaps. For each sub-series a set of values A0j and B0j is determined,
while the one set Ai, Gi is again based on the complete registration.

8.4.5 Accuracy analysis

The tidal analysis includes the computation of a standard deviation as an indication of the
quality of the analysis. If the proper input options are specified, additional quantities are
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determined which enable a thorough quality assessment of the results: a median error per
constituent, and auto-correlation function of the residue for various time lags.

The median error is defined by:

εi =

√
V V 2× Li
N − Z

(8.9)

εi mean error in i-th unknown
V V 2 standard deviation of the residuals
Li i-th main diagonal element of the inverted solution matrix
N number of observations used
Z total number of unknowns

It is noted that in the actual solution of the matrix the equation in amplitudes and phases is
rewritten in one in terms of cosine and sine functions:

A cos(ωt− ψ) = A cosψ cosωt+ a sinψ sinω = a cosωt+ b sinωt (8.10)

εi is the mean error for one of the elements of the unknowns {A0j, B0j, ak, bk}.

In the print file of a tidal analysis (extension <∗.pra>), values for the two parameters V V 1
and V V 2 are given. Parameter V V 1 is related to the numerical condition number of the
linear system of equations from which the tidal constituents are solved. Parameter V V 2
represents the standard deviation of the residuals.

8.5 Tidal prediction

The character of the tide at a given location in determined by the local values of the set A0,
Ai and Gi. If this set, or the main part of it, is known from literature or as the result of
the ANALYSIS part of TIDE, a prediction of tidal heights for any given period can be made.
Commonly used time intervals are 5, 6, 10, 15, 30 or 60 minutes. Time variation of the
astronomical fluctuations F and u over the considered period can be accounted for, and a
linear trend may be included.

Remark:
� In literature Ai and Gi are given in the local time zone of the station involved. Using

PREDICT will then also result in a prediction given in local time. This is in line with
ANALYSIS, where sets of Ai and Gi in local time are determined on the basis of an
observation series in local time.

The following two publications give (very small) sets of amplitudes and phases for a large
number of coastal stations world-wide: UKHO (annual), these only give data for O1, K1, M2
and S2 and SHOM (1982), contains data for at most the following 10 constituents: SA, Q1,
O1, K1, N2, M2, S2, MN4, M4, and MS4. However the Table des marées des grands ports du
monde (SHOM, 1982) is no longer in force since 2000.

8.6 Tide tables

Using a time-series of predicted or observed tidal heights with the corresponding time frame
as input, HILOW determines the times and heights of high and low water. Taking account of
the diurnal, semi-diurnal, or mixed character of the tide via windowing, a special filter tech-
nique is applied to ignore incidental peaks or measuring errors. Registration gaps and tide
gauge replacements are automatically taken care of. The results present the time and heights
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of high and low water per day. For each sub-series some statistical information, i.e. average
level, maximal and minimal levels, and mean rise and fall, is added.

Remark:
� The present approach to the preparation of tide tables is essentially different from the

generally used procedure, since it is not based on the differentiation of Equation (8.1).
This has the advantage that any observed tidal series, including meteorological effects,
can be processed as well. When processing observed series, the Delft3D-TIDE option
to detect physical extremes (measurement errors, etc.) is very useful, see item A.3
(filter parameters).
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A Input file formats

A description of the input file formats of the subsystems ANALYSIS, PREDICT, HILOW and
ASCON. For FOURIER no input file format need to be described.

A.1 ANALYSIS

ANALYSIS needs input data from two files, the input data file (with the required extension
<ina>) and the file with observations (with the required extension <obs>).

Input may often be entered in free format, but must sometimes be entered in fixed format.
Free format means that it makes no difference where you put the input on the line, taking into
account the order. Fixed format means that the input should be placed in a certain column
range (column fields). Text format means that you may enter any text, but left justified on the
input line (start in column 1). Pay attention to the maximum number of characters on input,
which may vary per input record.

In the input file several date-time groups for start and end of time periods have to be entered.
A date-time group consists of a date, followed by the time and separated by two blanks. The
date should be entered in a yymmdd format and the time in a hhmmss format. So, the
complete format for the date-time group is: yymmdd hhmmss.

A date-time group should always be entered left justified on the input line, like text input. For
example, for a time-series starting at October 20, 1989, 14:55:00 you should specify on the
input line:

891020 145500

The input is subdivided into a number of separate items. For each item the number of required
input lines will be specified, providing you with just that extra bit of information necessary for
a complete understanding of the input description.

The input description will be understood more easily if you consult the input example at the
end of this section from time to time.

Below we give a systematic, record for record, explanation for the input data file. The input
parameters are printed in bold type, immediately followed by an explanation. If needed, the
limitation of the sub-system with respect to input parameters is indicated.

Header lines (1 ≤ number of lines ≤ 20)

It is advised to start the input data file with header lines in which you can include some
relevant information for this analysis run. Relevant information may be the time period of
the observations, the name of the tidal station, the geographical position of the tidal station,
etc. Header lines are recognised by the system by the first character of a record. The first
character of a header line has to be ’+’ or ’∗’.

If the first character of a header line is ’+’, this header line will be copied to the output files. If
the first character of a header line is ’∗’, this header line will not be copied to the output files.

For example in case of ANALYSIS the ’plus header lines’ on the <∗.ina> file will include
relevant notes on the tidal analysis, the origin of applied set of components, coupling of com-
ponents, etc.
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The ’plus header lines’ for the time-series with observations, <∗.obs> file, may include rel-
evant information about the tidal station, for example geographical position, coastal/offshore
station, number of instruments, quality of measured data, etc.

HEADER(1) (text)
· · · · · ·
HEADER(Nheader) (text)

HEADER(i) is the i-th header line at the start of the input data file (Nheader ≤ 20). The
maximum information per line is 255 characters.

Tidal series (4 lines)

Nobs (free)
TB (fixed)
TE (fixed)
UNIT (text)

Nobs is the total number of observations to be read from the <∗.obs> file (file with
observations). Reading always start from the first observation on the <∗.obs>
file. Since the observation file also starts with a five-line identification header,
this is the first number on the sixth line of the<∗.obs> file. From the<∗.obs>
file the tidal series H(Nobs) will be read.

TB is the date-time group of the first observation H(1) of the observation time-
series. The date-time should be entered in the format given above:
yymmdd hhmmss, left justified on the input line.

TE is the date-time group of the last observationH(Nobs) of the observation time-
series. The date-time should be entered in the format given above:
yymmdd hhmmss, left justified on the input line.

UNIT is the description (text) for the unit of the observations. This text is only used for
generating appropriate header lines in the output files. No internal conversions
will follow. The maximum number of characters is 8. Example: CM WATER.

Options (1 line)

INFO(1:5) (free)

INFO is an option array with 5 options.

INFO(1) = 0: no GRAPHICS data file will be created. You do not intend to present
the results in graphical form.

= 1: a GRAPHICS data file will be created with the original time-series of
the observations, with the hindcast and with the residue.

= 2: same as INFO(1)=1 but time-series above are corrected for mean
level per instrument.

Explanation:
The three time-series are plotted in one frame. For scaling purposes,
it is desirable that the time-series to be plotted have approximately
the same mean value. The mean levels for observation and hindcast
are the same; per definition the mean of the residue in tidal analysis
equals zero. So, if the mean of observation (hindcast) differs sig-
nificantly from zero, application of this last option will allow a better
scaling of the graphical output.
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INFO(2) = 0: matrix of normal equations will not be printed.
= 1: matrix of normal equations will be printed; provides some extra infor-

mation in case of numerical problems.

INFO(3) = 0: no accuracy analysis.
= 1: an accuracy analysis will be performed, comprising the estimation of

mean errors for amplitudes and phases as well as the auto-correlation
of the residue.

INFO(4) = 0: it is assumed that there is no linear change (linear trend) in the mean
level of the observations.

= 1: a linear change of mean level will be computed for each instrument.

INFO(5) inactive option

Selection of component set (Ncomp + 1 lines)

Ncomp (free)
COMP(1) (text)
· · · · · ·
COMP(Ncomp) (text)

Ncomp is the total number of selected main components. Condition: Ncomp ≤ 234.
COMP(i) represents the name of component i from the selected set of components. The

components should be selected from the list of the 234 internally available tidal
components, see Appendix B.

The name of each component should be entered in upper cast, and be left justified on a new
line, resulting in Ncomp input lines for the set of components.

In principle, this set may be entered in any order of tidal frequency. A good habit, however, is to
provide the components in order of increasing tidal frequency. There is an important exception
in case of coupled components. For a group of coupled components the sub-components only
appear in the following lines:

Groups of coupled components (Ncoupl + 1 lines)

Ncoupl (free)

Ncoupl is the total number of coupled groups in the set of components. In section 8.3.4
you will find under which conditions coupling of components is required. Condi-
tion: 0 ≤ Ncoupl ≤ 10. If Ncoupl > 0 a series of input lines follow in order
to prescribe the coupling in detail. If Ncoupl = 0, no coupling will be applied.

The next input line(s) each define one group of coupled components. On each input line
the name of the main component is followed by the names of the sub-components and the
prescribed amplitude and phase relations.

MAIN(1) SUB(1,Nsub(1)) RHO(1,Nsub(1)) PSI(1,Nsub(1))
· · ·
MAIN(Ncoupl) SUB(Ncoupl,Nsub(Ncoupl)) RHO(Ncoupl,Nsub(Ncoupl))
PSI(Ncoupl,Nsub(Ncoupl)) (one record!)

MAIN(i) is the name of the main component for group i.
SUB(i,j) is the name of the sub-component j for group i.
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RHO(i,j) is the estimated amplitude ratio between sub-component j of group i and the
main component of group i. It is the amplitude of sub-component j divided by
that of its main component.

PSI(i,j) is the phase difference between sub-component j of group i and the main com-
ponent of group i. It is the estimated astronomical phase of component j minus
that of its main component, see also section 8.3.4 and Appendix B.

Nsub(i) is the total number of sub-components for group i. Condition: Nsub(i) ≤ 10
for each coupling group i.

Each well-defined group of coupled components will fit on one input line!

The items on input lines for coupling are not bound to column fields. The format is completely
free; only the order of the items is important.

Instruments (2Nins + 2 lines)

Nins (free)

N1(1) (free)
N2(1) (free)
· · · · · ·
N1(Nins) (free)
N2(Nins) (free)

Nins is the total number of instruments involved in the measurement of the selected
tidal series. Condition: Nins ≤ 10.

N1(i) is the sequence number of the first observation of instrument i.
N2(i) is the sequence number of the last observation of instrument i.

These sequence numbers are related to and must correspond to the sequence numbers in
the time-series H(Nobs) that will be analysed.

T1ins (fixed)
T2ins (fixed)
· · · · · ·
T1Nins (fixed)
T2Nins (fixed)

T1ins is the date-time group of the first observation of instrument 1.
T2ins is the date-time group of the last observation of instrument 1.
T1Nins is the date-time group of the first observation of the last instrument.
T2Nins is the date-time group of the last observation of the last instrument.
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Sub-series (2Nsub + 1 lines)

Nsub (free)

Nsub is the total number of sub-series in the selected tidal series. Condition: Nsub ≤
10. The minimum is 1 (one single series; no gaps; one instrument).

T1sub (fixed)
T2sub (fixed)
· · ·
T1Nsub (fixed)
T2Nsub (fixed)

T1sub is the date-time group of the first observation of sub-series 1.
T2sub is the date-time group of the last observation of sub-series 1.
T1Nsub is the date-time group of the first observation of the last sub-series.
T2Nsub is the date-time group of the last observation of the last sub-series.

In the case that a simple one instrument series without any gaps has to be analysed, these
date-time groups will be equal to TB and TE, respectively.

Block filter parameters (1 line)

Afilter Nfilter Mfilter (free)

Afilter, Nfilter and Mfilter are filter parameters for sub-system HILOW, used for smoothing
purposes. It is used to separate tidal and non-tidal extremes in the time-series. These proce-
dures are mainly important for data from measurements, which may contain instrumentation
errors and meteorological effects.

Afilter Weight factor for block filter.
Range: 0.01≤ Afilter ≤ 1.0
Default: 0.2

Nfilter Measure for the width of the block filter in terms of the number of values
preceding or following. The width of the filter follows from: 2Nfilter + 1.
Range: 1≤ Nfilter ≤ 6
Default: 2

Mfilter Number of iterations for the block filter.
Range: 1≤ Mfilter ≤ 3
Default: 2

We advise to start with the indicated default values for the filter parameters. In almost all
situations these defaults will satisfy, and give only real tidal maxima and minima. If this is
not the case, for instance if meteorological effects have given rise to extra extremes in the
observed time-series that you are considering, rerun the computation with larger values of the
filter parameters.

In ANALYSIS the block filters are not used. With this extra input line, this input file will also and
without changes serve as the input file for high/low water computations with HILOW, either for
the present observation series, or the corresponding hindcast series.
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Examples input files

The Tutorial ANALYSIS Example 3 <anaex3.ina> file:

+ Deltares
+ p.o. box 177 2600 MH Delft
+ TIDE Analysis and prediction of tides
+ Example 3 from Tutorial ANALYSIS
+ TIDAL ANALYSIS Centre point Bermuda Triangle, JUNE 1989

* ==================================================
720

890601 000000
890630 230000
CM WATER

1 0 1 1 0
26

2Q1
Q1
O1
M1
K1
J1
OO1
3MS2
MNS2
MU2
N2
M2
L2
S2
MSN2
2SM2
MO3
M3
2MNS4
MN4
M4
SN4
MS4
3SM4
3MO5
M6
3

S2 K2 0.284 0.00
N2 NU2 0.194 0.00
K1 P1 0.328 0.00

2
1 168 181 720

890601 000000
890607 230000
890608 120000
890630 230000

2
890601 000000
890607 230000
890608 120000
890630 230000

0.2 2 2

The Tutorial ANALYSIS Example 4 <anaex4.ina> file:

+ Deltares
+ p.o. box 177 2600 MH Delft
+ TIDE Analysis and prediction of tides
+ Example 4 from Tutorial ANALYSIS
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+ TIDAL ANALYSIS, year 2024

* =================================================================
8784
240101 000500
241231 230000
M WATER
0 0 0 0 0
38
SA
SSA
MSM
MM
MS0
KO0
MFM
2Q1
SIGMA1
Q1
RO1
O1
M1
PI1
K1
P1
J1
OO1
O2
MU2
N2
NU2
OP2
M2
L2
S2
K2
NO3
MO3
M3
SO3
MK3
SK3
MN4
M4
MS4
M6
2MS6
0
2
1 1594 1597 8784
240101 000500
240307 090500
240307 120000
241231 230000
6
240201 120500
240307 090500
240307 120000
240416 140000
240417 130000
240607 080000
240607 160000
240724 090000
240724 110000
241009 090000
241009 120000
241231 230000
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0.2 2 2

A.2 PREDICT

If you have to prepare an input file for PREDICT by yourself, it is necessary to know the exact
format of the <∗.inp> file.

At some places, input data can be entered in free format, but elsewhere it may need to be
entered in fixed format. Free format means that it makes no difference where you put the input
on the line, as long as you take into account the order in which it is supplied. Fixed format
means that the input should be placed in certain column ranges (column fields). Text format
means any text, as long as it is left justified on the input line (start in column 1). Pay attention
to the maximum number of characters on input, which may vary per input.

In the input file several date-time groups for start and end of time periods have to be entered.
A date-time group consists of a date, followed by the time and separated by two blanks. The
date should be entered in a yymmdd format and the time in a hhmmss format. So, the
complete format for the date-time group is: yymmdd hhmmss. A date-time group should
always be entered left justified on the input line, like text input. For example, for a time-series
starting at October 20, 1989, 14:55:00 you should specify on the input line:

891020 145500

The input is subdivided in a number of separate items. For each item the number of required
input lines will be specified. This should provide you with just that extra bit of information
necessary for a complete understanding of the input description.

The input description will be understood more easily if you consult the input example at the
end of this section from time to time.

Below we give a systematic, record for record, explanation of the structure of the input data
file. The input parameters are printed in bold character type, immediately followed by an
explanation of the input. If needed, the limitation of the sub-system with respect to the input
parameters is indicated.

Header lines (1 ≤ number of lines ≤ 20)

It is advised to start the input data file with header lines in which you can include some
relevant information for this prediction run. Relevant information may be the time period of
the observations, the name of the tidal station, the geographical position of the tidal station,
etc. Header lines are recognised by the system by the first character of a record. The first
character of a header line has to be ’+’ or ’∗’.

If the first character of a header line is ’+’, this header line will be copied to the output files. If
the first character of a header line is ’∗’, this header line will not be copied to the output files.

HEADER(1) (text)
· · · · · ·
HEADER(Nheader) (text)

HEADER(i) is the i-th header line at the start of the input data file (Nheader ≤ 20) The
maximum information per line is 255 characters.
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Time period for prediction (3 lines)

TB (fixed)
TE (fixed)
UNIT (text)

TB is the date-time group of the first observation H(1) of the observation time-
series. The date-time should be entered in the format given above:
yymmdd hhmmss,
left justified on the input line.

TE is the date-time group of the last observationH(Nobs) of the observation time-
series. The date-time should be entered in the format given above:
yymmdd hhmmss,
left justified on the input line.

UNIT is the description (text) for the unit of the observations. This text is only used for
generating appropriate header lines in the output files. No internal conversions
will follow. The maximum number of characters is 8. Example: CM WATER.

Nobs is the total number of observations to be read from the <∗.obs> file (file with
observations). Reading always start from the first observation on the <∗.obs>
file. Since the observation file also starts with a five-line identification header,
this is the first number on the sixth line of the<∗.obs> file. From the<∗.obs>
file the tidal series H(Nobs) will be read.

Names, amplitudes and phases of the component set (Ncomp + 1 lines)

The station dependent amplitudes and phases may come from the Admiralty Tide Tables
(UKHO (annual)), but are often originating from ANALYSIS. In that case it is advised to use
the PREDICT Input Processor.

Ncomp (free)
COMP(1) A(1) G(1) (fixed)
· · · · · ·
COMP(Ncomp) A(Ncomp) G(Ncomp) (fixed)

Ncomp is the total number of components that you want to use in the prediction. There
is no restriction on the number: all 234 internally available components may be
used.

COMP(i) represent the names of the selected set of components. All components have
to be chosen from the set of available components in Appendix B. The format
is A8. They must be entered in upper cast (capital letters).

A(i) represents the amplitudes for the station. The unit in which the amplitudes
are expressed fixes the unit of the prediction time-series that will be produced.
Format: F10.3.

G(i) represents the station’s phases or improved Kappa-numbers. The unit in which
they MUST be entered is degrees. Format: F10.1.

This set may be entered in any order of tidal frequency. It is the convention to provide them in
order of increasing tidal frequency, since this simplifies visual checks.

As stated above, the parameters on this input line are bound to specific column fields.
The name of each component must be entered in the leftmost 8 columns of the record; the
amplitude A in columns 9–18 and the phase G in column field 19–28. Always use a floating
point representation when entering these values; only then it does not matter where you put
the value within the assigned column field.
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Time step in prediction (1 line)

DELT

DELT is the time step to be applied in the prediction. The unit of the time step is
MINUTES.

Sub-series to be used in prediction (Nsub+1 lines)

Nsub (free)
T1sub(1) A(1) B(1) (fixed)
· · · · · ·
T1sub(Nsub) A (Nsub) B (Nsub) (fixed)

Nsub is the number of sub-series to be used in the prediction (minimum value: 1). The
prediction series should be split up in more than one sub-series if a prediction
for a long time period is made. This is related to the fact that the component-
dependent so-called nodal factors u and F ("constant for the period of pre-
diction"), which are computed by the system, are actually slowly varying with
time. Most of these nodal factors have a cycle period of about 18.61 years.
For prediction periods exceeding two months, you should subdivide the period
in blocks of at maximum two months. The system then computes u and F per
sub-series, which improves the accuracy of the prediction.

T1sub(1) is the date-time group of the first observation of the first sub-series.
A(1) is the mean level for the first sub-series.
B(1) (in units per hour) indicates the linear change with time of the first sub-series.

The format of the record is: A6, 2X, A6, F10.3, F10.3.
T1sub(Nsub) is the date-time group of the first observation of the last sub-series.
A (Nsub) is the mean level for the last sub-series.
B (Nsub) (in units per hour) indicates the linear change with time of the last sub-series.

The format of the record is: A6, 2X, A6, F10.3, F10.3

The linear trend is defined with respect to the MIDDLE TIME POINT of the period of the
(sub)series. In most cases the linear trend will be zero. When the linear trend is non-zero,
however, and you split up the period to be predicted in a number of sub-series, you should be
aware that this will result in a (linear) change of the mean level per sub-series too!. This
means that you have to adjust the mean levels of the sub-series in your input accordingly, in
order to effect the correct transition from one sub-series to the next.

This looks more difficult than it is. A simple check to see if you have prescribed the correct
mean levels given your linear change, is to make a prediction with all amplitudes equal to
zero. This should result in a monotonously increasing (positive trend) or decreasing (negative
trend) straight line. The presence of jumps at the transition of sub-series, easily detected
from your output file <∗.prp>, requires reconsideration of the mean levels that you applied
in those sub-series. A similar, slightly more complicated situation occurs if the linear trend
information comes from a computation with ANALYSIS, in which more than one instrument
(more than one trend) played a role.

Remark:
� You don’t have to specify the end of the entered sub-series. Each sub-series ends one

time step before the first value of the next sub-series, resulting in a continuous overall
series.

As stated above, the parameters (T1, A ,B ) on these input lines are bound to specific column
fields. Parameter T1sub is a date-time group, so should be entered in the 14 leftmost columns.
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Parameter A should be in column field 15–24 and parameter B in column field 25–34.

Always use a floating point representation when entering values for A and B; only then it
does not matter where you put the value in the assigned column field.

Remark:
� The PREDICT Input Processor automatically generates sub-series of length 1 month.

Example input file

The Tutorial PREDICT Example 2 <prdex2.inp> file:

+ Deltares
+ p.o. box 177 2600 MH Delft
+ TIDE Analysis and prediction of tides
+ Example 2 from Tutorial PREDICTION
+ PREDICTION HOOK OF HOLLAND , 51 59 NB 04 07 EL NOV 1999-FEB 2000

* ======================================================================
991101 000000
000229 230000
CM
60
SA 10.350 183.9
MS0 2.410 42.1
2Q1 .524 31.3
Q1 3.988 146.4
O1 9.974 190.4
M1 .455 41.4
P1 3.336 348.3
S1 1.328 285.1
K1 7.666 3.7
3MKS2 .782 325.6
3MS2 1.462 318.0
OQ2 1.489 359.7
MNS2 2.278 186.8
2ML2S2 1.681 355.9
NLK2 1.552 68.0
MU2 7.806 204.8
N2 11.777 57.9
NU2 4.474 55.6
MSK2 .521 271.6
MPS2 1.504 168.8
M2 77.405 85.7
MSP2 1.543 53.1
MKS2 1.735 245.1
LABDA2 2.769 97.6
2MN2 7.105 289.6
T2 1.339 131.5
S2 18.797 144.9
K2 5.273 149.1
MSN2 1.722 355.0
2SM2 2.127 24.3
SKM2 .972 18.7
2MK3 .695 188.4
MK3 .935 291.2
3MS4 1.661 244.6
MN4 6.063 133.8
2MLS4 2.086 317.7
M4 16.503 162.3
2MKS4 1.455 294.2
SN4 .925 249.5
3MN4 1.396 356.2
MS4 10.433 217.9
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MK4 2.301 212.0
2MSN4 1.502 58.4
S4 1.073 288.6
3MK5 1.353 210.2
2MP5 .808 301.7
3MO5 1.625 14.1
3MNS6 1.083 226.7
4MS6 1.288 251.0
2MN6 2.187 98.2
2MNU6 .987 100.7
M6 4.245 129.8
2MS6 3.607 188.0
2MK6 1.018 173.5
3MN8 1.627 193.7
M8 2.270 225.5
2MSN8 1.417 259.4
3MS8 3.154 277.9
2(MS)8 1.300 337.5
2(MS)N10 .016 37.8
60.
4
991101 000000 4.20 0.
991201 000000 4.20 0.
000101 000000 4.20 0.
000201 000000 4.20 0.

A.3 HILOW

Input files for HILOW are generated by either ANALYSIS or PREDICT.

Remark:
� Only if you prepare the input file”by hand”, the remainder of this section is important

At the beginning of the file, header lines are expected. The number of header lines that can
be included in the files is not fixed, but should at least be one and not exceed 20.

Header lines are recognised by the system by the first character of a record, the first char-
acter of a header line has to be ’+’ or ’∗’.

The header lines are directly followed by the data. As the data are read free-formatted there
are no conditions with respect to the layout of the data part of the file.

Remark:
� Never use a ’+’ sign to indicate positive values. It is possible that the record containing

this value is identified as a header line. A value without a sign is identified as a positive
value.

The number of observations per line (a line is a record) is free. The unit of the observations
(metre, centimetre, inches) is free. We advise to choose centimetres as the unit for observa-
tions, since the number of printed decimal digits for the results is fixed. So, for centimetres
the printed results are actually more accurate. Input data may sometimes be entered in free
format but has at other times to be entered in fixed format. Free format means that it makes
no difference where you put the input on the line, as long as you take into account the order
in which it is supplied. Fixed format means that the input should be placed in certain column
ranges (column fields). Text format means any text, as long as it is left justified on the input
line (start in column 1). Pay attention to the maximum number of characters on input, which
may vary per input.
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In the input file several date-time groups for start and end of time periods have to be entered.
A date-time group consists of a date, followed by the time and separated by two blanks. The
date should be entered in a yymmdd format and the time in a hhmmss format. So, the
complete format for the date-time group is: yymmdd hhmmss. A date-time group should
always be entered left justified on the input line, like text input. For example, for a time-series
starting at October 20, 1989, 14:55:00 you should specify on the input line:

891020 145500

The input is subdivided in a number of separate items. For each item the number of required
input lines will be specified. This should provide you with just that extra bit of information
necessary for a complete understanding of the input description.

The input description will be understood more easily if you consult the input example at the
end of this section from time to time.

Below, we give a systematic, record for record, explanation of the structure of the input data
file. The relevant input parameters are printed in bold character type, immediately followed
by an explanation of the input. If needed, the limitation of the sub-system with respect to the
input parameters is indicated.

Header lines (1 ≤ number of lines ≤ 20)
It is advised to start the input data file with header lines in which you can include some
relevant information for this analysis run. Relevant information may be the time period of
the observations, the name of the tidal station, the geographical position of the tidal station,
etc. Header lines are recognised by the system by the first character of a record. The first
character of a header line has to be ’+’ or ’∗’.

If the first character of a header line is ’+’, this header line will be copied to the output files. If
the first character of a header line is ’∗’, this header line will not be copied to the output files.

HEADER(1) (text)
· · · · · ·
HEADER(Nheader) (text)

HEADER(i) is the i-th header line at the start of the input data file (Nheader ≤ 20) The
maximum information per line is 255 characters.

Tidal series (4 lines)

Nobs (free)
TB (fixed)
TE (fixed)
UNIT (text)

Nobs is the total number of observations to be read from the <∗.obs> file (file with
observations). Reading always start from the first observation on the <∗.obs>
file. Since the observation file also starts with a five-line identification header,
this is the first number on the sixth line of the<∗.obs> file. From the<∗.obs>
file the tidal series H(Nobs) will be read.

TB is the date-time group of the first observation H(1) of the observation time-
series. The date-time should be entered in the format given above:
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yymmdd hhmmss,
left justified on the input line.

TE is the date-time group of the last observationH(Nobs) of the observation time-
series. The date-time should be entered in the format given above:
yymmdd hhmmss,
left justified on the input line.

UNIT is the description (text) for the unit of the observations. This text is only used for
generating appropriate header lines in the output files. No internal conversions
will follow. The maximum number of characters is 8. Example: CM WATER.

Options (1 line)

INFO(1:5) (free)

INFO is an option array with 5 options, used only in ANALYSIS (The explanation of INFO( ) is
not further explained here). You must enter a line with 5 integer numbers here.

Selection of component set (Ncomp + 1 lines)

Remarks:
� If this is a new and specially made HILOW -input file, just enter: “1”.
� If this is a new and specially made HILOW -input file, just enter: “M2”. Then proceed to

the line with Ncoupl.

Ncomp (free)
COMP(1) (text)
· · · · · ·
COMP(Ncomp) (text)

Ncomp is the total number of selected main components. Condition: Ncomp ≤ 234.
COMP(i) represents the name of component i from the selected set of components. The

components should be selected from the list of the 234 internally available tidal
components, see Appendix B.

The name of each component should be entered in upper cast, and be left justified on a new
line, resulting in Ncomp input lines for the set of components.

In principle, this set may be entered in any order of tidal frequency. A good habit, however, is
to provide the components in order of increasing tidal frequency.

Groups of coupled components (1 + Ncoupl lines)

Remark:
� If this is a new and specially made HILOW-input file, just enter: “0”. Then proceed to

the line with Nins.

Ncoupl (free)

Ncoupl is the total number of coupled groups in the set of components. In section 8.3.4
you will find under which conditions coupling of components is required. Condi-
tion: 0 ≤ Ncoupl ≤ 10. If Ncoupl > 0 a series of input lines follow in order
to prescribe the coupling in detail. If Ncoupl = 0, no coupling will be applied.

The next input line(s) each define one group of coupled components. On an input line the
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name of the main component is supposed to be followed by the names of the sub-components
and the prescribed amplitude and phase relations.

MAIN(1) SUB(1,Nsub(1)) RHO(1,Nsub(1)) PSI(1,Nsub(1))
· · ·
MAIN(Ncoupl) SUB(Ncoupl,Nsub(Ncoupl)) RHO(Ncoupl,Nsub(Ncoupl))
PSI(Ncoupl,Nsub(Ncoupl)) (one record!)

MAIN(i) is the name of the main component for group i.
SUB(i,j) is the name of the sub-component j for group i.
RHO(i,j) is the estimated amplitude ratio between sub-component j of group i and the

main component of group i. It is the amplitude of sub-component j divided by
that of its main component.

PSI(i,j) is the phase difference between sub-component j of group i and the main com-
ponent of group i. It is the estimated astronomical phase of component j minus
that of its main component.

Nsub(i) is the total number of sub-components for group i.

Condition: Nsub(i)≤ 10 for each coupling group i.

Each well-defined group of coupled components will fit on one input line!

The items on input lines for coupling are not bound to column fields. The format is completely
free; only the order of the items is important.

Instruments (2Nins + 2 lines)

Nins (free)
N1(1) (free)
N2(1) (free)
· · · · · ·
N1(Nins) (free)
N2(Nins) (free)

Nins is the total number of instruments involved in the measurement of the selected
tidal series. Condition: Nins ≤ 10.

N1(i) is the sequence number of the first observation of instrument i.
N2(i) is the sequence number of the last observation of instrument i.

These sequence numbers are related to and must correspond to the sequence numbers in
the time-series H(1:Nobs) that forms the basis for the Tide Tables.

T1ins (fixed)
T2ins (fixed)
· · · · · ·
T1Nins (fixed)
T2Nins (fixed)

T1ins is the date-time group of the first observation of instrument 1.
T2ins is the date-time group of the last observation of instrument 1.
T1Nins is the date-time group of the first observation of the last instrument.
T2Nins is the date-time group of the last observation of the last instrument.

Sub-series (2Nsub + 1 lines)
Nsub (free)
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Nsub is the total number of sub-series in the selected tidal series.
Condition: Nsub ≤ 10. The minimum is 1 (one single series; no gaps; one
instrument).

T1sub (fixed)
T2sub (fixed)
· · · · · ·
T1Nsub (fixed)
T2Nsub (fixed)

T1sub is the date-time group of the first observation of sub-series 1.
T2sub is the date-time group of the last observation of sub-series 1.
T1Nsub is the date-time group of the first observation of the last sub-series.
T2Nsub is the date-time group of the last observation of the last sub-series.

In the case that a simple one instrument series without any gaps has to be analysed, these
date-time groups will be equal to TB and TE, respectively.

Block filter parameters (1 line)

Afilter Nfilter Mfilter (free)

Afilter, Nfilter and Mfilter above are block filter parameters. The block filter is used to sepa-
rate tidal and non-tidal extremes in the time-series. These procedures are mainly important
for data from measurements, which may contain instrumentation errors and meteorological
effects.

Afilter Weight factor for block filter
Range: 0.01≤ Afilter ≤ 1.0
Default: 0.2

Nfilter Measure for the width of the block filter in terms of the number of values
preceding or following. The width of the filter follows from: 2Nfilter + 1

.

Range: 1≤ Nfilter ≤ 6
Default: 2

Mfilter Number of iterations for the block filter.
Range: 1≤ Mfilter ≤ 3
Default: 2

We advise to start with the indicated default values for the filter parameters. In almost all
situations these defaults will satisfy, and give only real tidal maxima and minima. If this is
not the case, for instance if meteorological effects have given rise to extra extremes in the
observed time-series that you are considering, rerun the computation with larger values of the
filter parameters.

Example input file

The Tutorial HILOW Example 1 <hlwex1.inh> file:

+ Deltares
+ p.o. box 177 2600 MH Delft
+ TID Analysis and prediction of tides
+ Example 1 from Tutorial HILOW
+ HIGH/LOW WATER COMPUTATION
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* ATLANTIS 10 00 N 00 00 EL (dt=30 min)

* ==================================================================
1440
270601 000000
270630 233000
M WATER
0 0 0 0 0
38
SA
SSA
MSM
MM
MS0
KO0
MFM
2Q1
SIGMA1
Q1
RO1
O1
M1
PI1
K1
P1
J1
OO1
O2
MU2
N2
NU2
OP2
M2
L2
S2
K2
NO3
MO3
M3
SO3
MK3
SK3
MN4
M4
MS4
M6
2MS6
0
1
1 1440

270601 000000
270630 233000
1

270601 000000
270630 233000
0.2 2 2
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A.4 ASCON

In this section we will discuss the data on the input data file of ASCON. Unless otherwise
stated the input is in free format. Do mind the order of entering the data. Text input should be
always be entered left justified on the input line.

Apart from the identification header, the main input consists of date-time groups. A date-time
group consists of a date, followed by the time and separated by two blanks. The date should
be entered in a yymmdd format and the time in a hhmmss format. So, the complete format
for the date-time group is: yymmdd hhmmss. A date-time group should always be entered
left justified on the input line, like text input. For example, for a time-series starting at October
20, 1989, 14:55:00 you should specify on the input line:

891020 145500

The input is subdivided in a number of separate items. For each item the number of required
input lines will be specified, providing you with the information necessary for a complete un-
derstanding of the input description.

Understanding the input description will be easier if read the example at the end of this section
from time to time.

The input parameters are printed in bold character type, immediately followed by an explana-
tion of the input. If needed, the limitation of the sub-system with respect to the input parame-
ters is indicated.

Header lines (1 ≤ number of lines ≤ 20)

It is advised to start the input data file with header lines in which you can include some
relevant information for this analysis run. Relevant information may be the time period of
the observations, the name of the tidal station, the geographical position of the tidal station,
etc. Header lines are recognised by the system by the first character of a record. The first
character of a header line has to be ’+’ or ’∗’.

If the first character of a header line is ’+’, this header line will be copied to the output files. If
the first character of a header line is ’∗’, this header line will not be copied to the output files.

HEADER(1) (text)
· · · · · ·
HEADER(Nheader) (text)

HEADER(i) is the i-th header line at the start of the input data file (Nheader ≤ 20). The
maximum information per line is 255 characters.

Date time groups for V0 + U and F (var.)

TI (fixed)

TI represents the date-time group (yymmdd hhmmss) for which the astronomi-
cal arguments V0 + u and F will be computed. You can specify as many date-
time groups as you like, However one date-time group per input line, Format:
I6,2X,I6.
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Input file formats

Selection of component set (Ncomp lines)

COMP(1) (text)
· · · · · ·
COMP(Ncomp) (text)

COMP(i) represents the name of component i from the selected set of components. The
components should be selected from the list of available tidal components in
Appendix B.

The name of each component should be entered in upper cast and left justified on a new line,
resulting in Ncomp input lines for the set of components.

This set of components MUST be entered in order of increasing frequency.

Example input file

The Tutorial ASCON Example 1 <ascex1.inc> file:

+ Deltares
+ p.o. box 177 2600 MH Delft
+ TIDE Analysis and prediction of tides
+ Example 1 from Tutorial ASCON
+ ASTRONIMICAL ARGUMENTS Centre point Bermuda Triangle
+ FOR 01/01/1999,01/01/2000 AND 01/01/2001

* =====================================================================
990101 000000
000101 000000
010101 000000
2Q1
Q1
O1
M1
K1
P1
J1
OO1
3MS2
MNS2
MU2
N2
NU2
M2
L2
S2
K2
MSN2
2SM2
MO3
M3
2MNS4
MN4
M4
SN4
MS4
3SM4
3MO5
M6

A.5 FOURIER

No specific file formats needed.
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B List of tidal components (internal component base)

The set of components can be divided in primary components, which appear in the equilib-
rium tide (No land masses; only one deep ocean), and compound components. The latter are
linear combinations of primary components. The names and frequencies of all 234 internally
available components of TIDE are given below. For the primary components the relative mag-
nitude in the equilibrium tide is given as well. For the selection of components in an analysis
input file, relative importance in neighbouring stations is often a guideline. For North Sea
circumstances, the set of 60 constituents given in the example just preceding section A.3 is a
good choice. For components that may appear as sub-components in astronomical coupling
in case of short series, the equilibrium amplitude relation with their main component is given
as well. The equilibrium phase relation is equal to zero.

Remark:
� In case astronomical coupling is necessary, you should always first try to use amplitude

and phase relations based on a long period analysis of a neighbouring station. Only if
such information is not available, you may resort to the equilibrium tide relations given
below.

Component
Name

Angular
Frequency
(degr/hour)

Amplitude in
equilibrium tide

Amplitude
coupling relation

SA 0.0410686 0.01156
SSA 0.0821373 0.07281
MSM 0.4715211 0.01579
MM 0.5443747 0.08254
MSF 1.0158958 0.01369
MS0 1.0158958
MF 1.0980331 0.15647
KO0 1.0980331
MK0 1.0980331
SNU 1.4874169
SN 1.5602705
MSTM 1.5695542 0.00569
MFM 1.6424078 0.02996
2SM 2.0317916
MSQM 2.1139289 0.00478
MQM 2.1867825 0.00396
2SMN 2.5761663
2OK1 12.8450025
2Q1 12.8542862 0.00955 0.025 × O1
NJ1 12.8542862
SIGMA1 12.9271398 0.01152
MUK1 12.9271398
NUJ1 12.9271398
Q1 13.3986609 0.07343 0.191 × O1
NK1 13.3986609
RO1 13.4715145 0.01395 0.036 × O1
NUK1 13.4715145
O1 13.9430356 0.38358
TAU1 14.0251728 0.00504
MP1 14.0251728
M1B 14.4874103 0.01065 0.350 × M1A
M1C 14.4920521
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Component
Name

Angular
Frequency
(degr/hour)

Amplitude in
equilibrium tide

Amplitude
coupling relation

M1A 14.4966939 0.02964
M1 14.4966939 0.03150 0.082 × O1
NO1 14.4966939
CHI1 14.5695476 0.00580
LP1 14.5695476
PI1 14.9178647 0.01028
TK1 14.9178647
P1 14.9589314 0.17543 0.328 × K1
SK1 14.9589314
S1 15.0000000 0.00416
K1 15.0410686 0.53496
MO1 15.0410686
SP1 15.0410686
PSI1 15.0821353 0.00109
RP1 15.0821353
FI1 15.1232059 0.00755
KP1 15.1232059
THETA1 15.5125897 0.00578
LABDAO1 15.5125897
J1 15.5854433 0.03022 0.079 × O1
MQ1 15.5854433
2PO1 15.9748272
SO1 16.0569644
OO1 16.1391017 0.01939 0.051 × O1
2KO1 16.1391017
UPSILON1 16.6834764 0.00372
KQ1 16.6834764
2MN2S2 26.4079379
3MKS2 26.8701753
2NS2 26.8794590
3MS2 26.9523126
OQ2 27.3416964
MNK2 27.3416964
EPSILON2 27.4238337 0.00671
MNS2 27.4238337
2ML2S2 27.4966873
MNUS2 27.4966873
MNK2S2 27.5059710
2MS2K2 27.8039339
O2 27.8860711
NLK2 27.8860711
2MK2 27.8860711
2N2 27.8953548 0.02303 0.132 × N2
MU2 27.9682084 0.02776 0.031 × M2
2MS2 27.9682084
SNK2 28.3575922
NA2 28.3986628
N2 28.4397295 0.17398 0.191 × M2
KQ2 28.4397295
NB2 28.4807962
NU2 28.5125831 0.03304 0.194 × N2
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List of tidal components (internal component base)

Component
Name

Angular
Frequency
(degr/hour)

Amplitude in
equilibrium tide

Amplitude
coupling relation

3MSN2 28.6040041
2KN2S2 28.6040041
OP2 28.9019669
MSK2 28.9019669
GAMMA2 28.9112506 0.00273
ALFA2 28.9430356 0.00313
MPS2 28.9430356
MA2 28.9430356
M2 28.9841042 0.90872
KO2 28.9841042
MSP2 29.0251728
MB2 29.0251728
DELTA2 29.0662415
MKS2 29.0662415
M2(KS)2 29.1483788
2SN(MK)2 29.3734880
LABDA2 29.4556253 0.00466 0.005 × M2
SNM2 29.4556253
2MN2 29.5284789
L2 29.5284789 0.02663 0.029 × M2
L2A 29.5284789 0.02569
L2B 29.5377626 0.00704 0.274 × L2A
2SK2 29.9178627
T2 29.9589333 0.02476 0.059 × S2
S2 30.0000000 0.42248
KP2 30.0000000
R2 30.0410667 0.00366 0.009 × S2
K2 30.0821373 0.12004 0.284 × S2
MSNU2 30.4715211
MSN2 30.5443747
ZETA2 30.5536584 0.00134
ETA2 30.6265120 0.00702
KJ2 30.6265120
MKN2 30.6265120
2KM(SN)2 30.7086493
2SM2 31.0158958
SKM2 31.0980331
2MS2N2 31.0887494
2SNU2 31.4874169
2SN2 31.5602705
SKN2 31.6424078
MQ3 42.3827651
NO3 42.3827651
MO3 42.9271398
2MK3 42.9271398
2MP3 43.0092771
M3 43.4761563 0.01780
NK3 43.4807981
SO3 43.9430356
MP3 43.9430356
MK3 44.0251728
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Component
Name

Angular
Frequency
(degr/hour)

Amplitude in
equilibrium tide

Amplitude
coupling relation

SP3 44.9589314
2MQ3 44.5695476
SK3 45.0410686
2SO3 46.0569644
K3 45.1232059
4MS4 55.9364168
2MNS4 56.4079379
3MK4 56.8701753
MNLK4 56.8701753
3MS4 56.9523126
MSNK4 57.3416964
MN4 57.4238337
MNU4 57.4966873
2MLS4 57.4966873
2MSK4 57.8860711
M4 57.9682084
2MKS4 58.0503457
SN4 58.4397295
3MN4 58.5125831
2SMK4 58.9019669
MS4 58.9841042
MK4 59.0662415
2SNM4 59.4556253
2MSN4 59.5284789
SL4 59.5284789
S4 60.0000000
SK4 60.0821373
2SMN4 60.5443747
3SM4 61.0158958
2SKM4 61.0980331
MNO5 71.3668693
3MK5 71.9112440
3MP5 71.9933813
M5 72.4649024
MNK5 72.4649024
2MP5 72.9271398
MSO5 72.9271398
3MO5 73.0092771
MSK5 74.0251728
3KM5 74.1073101
2(MN)S6 84.8476674
3MNS6 85.3920421
4MK6 85.8542796
2NM6 85.8635632
4MS6 85.9364168
2MSNK6 86.3258006
2MN6 86.4079379
2MNU6 86.4807915
3MSK6 86.8701753
M6 86.9523126
MSN6 87.4238337
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List of tidal components (internal component base)

Component
Name

Angular
Frequency
(degr/hour)

Amplitude in
equilibrium tide

Amplitude
coupling relation

MNK6 87.5059710
4MN6 87.4966873
MKNU6 87.5788246
2(MS)K6 87.8860711
2MS6 87.9682084
2MK6 88.0503457
2SN6 88.4397295
3MSN6 88.5125831
MKL6 88.5947204
2SM6 88.9841042
MSK6 89.0662415
S6 90.0000000
2MNO7 100.3509735
2NMK7 100.9046319
M7 101.4490066
2MSO7 101.9112440
MSKO7 103.0092771
2(MN)8 114.8476674
3MN8 115.3920421
3MNKS8 115.4741794
M8 115.9364168
2MSN8 116.4079379
2MNK8 116.4900752
3MS8 116.9523126
3MK8 117.0344499
2SNM8 117.4238337
MSNK8 117.5059710
2(MS)8 117.9682084
2MSK8 118.0503457
3SM8 118.9841042
2SMK8 119.0662415
S8 120.0000000
2(MN)K9 129.8887361
3MNK9 130.4331108
4MK9 130.9774855
3MSK9 131.9933813
4MN10 144.3761463
M10 144.9205210
3MSN10 145.3920421
4MS10 145.9364168
2(MS)N10 146.4079379
2MNSK10 146.4900752
3M2S10 146.9523126
4MSK11 160.9774855
M12 173.9046253
4MSN12 174.3761463
5MS12 174.9205210
3MNKS12 175.4741794
4M2S12 175.9364168
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C Filename conventions

When you execute the TIDE software you will be prompted for the names of data files to be
selected from file lists in menu boxes.

For TIDE the following (compulsory) extensions are defined:

C.1 ANALYSIS

Input files:

<∗.ina> for an input file of ANALYSIS
<∗.obs> for the file with the time-series of observations

Output files:

<∗.pra> for the print file with report and error messages of ANALYSIS
<∗.cmp> for the file with the tidal constants
<∗.hdc> for the file with the time-series of the hindcast
<∗.res> for the file with the time-series of residuals
<∗.tka> for the file with the plot data of ANALYSIS

C.2 PREDICT-GUI

Input:

� Manual input

Input files:

<∗.ina> File according the analysis input file
<∗.cmp> Result file with components from the sub-system ANALYSIS

Output file:

<∗.inp> File suitable as input file for subsystem PREDICT

C.3 PREDICT

Input file:

<∗.inp> for an input file of PREDICT

Output files:

<∗.prp> for the print file with report and error messages of PREDICT
<∗.prd> for the file with the predicted time-series
<∗.tkp> for the file with the plot data of PREDICT
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C.4 HILOW-GUI

Input:

� Manual input

Input file:

<∗.ina/inp> File according the ANALYSIS/PREDICT input file

Output file:

<∗.inh> File suitable as input file for subsystem HILOW

C.5 HILOW

Input file:

<∗.inh> for an input file of HILOW

Output files:

<∗.prh> for the print file
<∗.hlw> for the file with tide tables

C.6 ASCON

Input file:

<∗.inc> for an input file of ASCON

Output file:

<∗.prc> for the output file of ASCON

C.7 FOURIER

Standard Fourier Transform

Input:

� Manual input

Input file:

<∗.res> Time-series result file from ANALYSIS
- Manual input

Output file:

<∗.prf> for the print file of Standard Fourier Transform
<∗.tkf> for file with plot data of Standard Fourier Transform
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Filename conventions

Fast Fourier Transform

Input:

� Manual input

Input file:

<∗.res> Time-series result file from ANALYSIS

Output file:

<∗.prt> for the print file of Fast Fourier Transform
<∗.tkt> for file with plot data of Fast Fourier Transform
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D Messages from Delft3D-TIDE

Error messages, warnings and/or Informative messages are given for all the 5 subsystems
e.g. ANALYSIS, PREDICT, HILOW, ASCON and FOURIER.

D.1 ANALYSIS

In the ANALYSIS messages on fatal errors and warnings are automatically generated. Both
result from a thorough overall screening of the individual input parameters. Finally the consis-
tency of the whole input set is checked.

If fatal errors have been found the program will abort after printing all the error messages on
the print file <∗.pra>. Therefore, if any errors have occurred, check the Input Interpretation
Report thoroughly.

In case of warnings the program will continue normally with the computation. The warnings
are often not that serious that they will abort the computational process. On the other hand,
they deserve your attention because something may be wrong. This holds especially for the
warnings regarding the time interval of the data and those on the violation of the Rayleigh
criterion. Warnings are also added to the print file <∗.pra>. In the editor you can easily
search for the keywords ERROR and WARNING in order to find all error messages respec-
tively warnings.

D.1.1 Error messages

A list of all error messages is given below. Only the first line of the error message on your
print file is printed here. The error messages in the Input Interpretation Report on the PRA-file
contain much more information. The explanations should guide you in the interpretation of the
error. The remedies give hints and advice on how to remove the error.

ERROR 1 INCORRECT TIMESPEC FOR TIDAL SERIES
Explanation: The end of the tidal series H(1:Nobs) precedes the start of the series.
Remedy: Verify the input; ensure that the start time precedes the end time.

ERROR 2 NUMBER OF MAIN COMPONENTS TOO LARGE
Explanation: The actual number of main components exceeds 234.
Remedy: Reduce the number of main components to less than or equal to the

maximum available 234 components.

ERROR 3 TOO MANY GROUPS IN COUPLED COMPONENTS
Explanation: The actual number of coupled groups of components should not ex-

ceed 10.
Remedy: Reduce the number of groups to less than or equal to 10 by leaving

out the ones you consider less important.

ERROR 4 MAIN COMPONENT IN COUPLED GROUP INCORRECT
Explanation: The indicated group contains a main component that is not present

in the group of selected main components (Ncomp).
Remedy: Verify the name of the selected main component.
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ERROR 5 NUMBER OF COUPLED COMPONENTS PER GROUP TOO
LARGE

Explanation: The indicated group contains more than 10 sub-components.
Remedy: Reduce the number of sub-components to less than or equal to 10

by leaving less important ones out of the computation.

ERROR 6 COUPLED GROUP CONTAINS ILLEGAL SUB-COMPONENT
Explanation: The indicated group contains a sub-component that is not present in

the list of tidal constituents.
Remedy: Verify the names of the sub-components that you want to be included

in this group.

ERROR 7 OVERLAP IN COUPLED GROUP OF COMPONENTS
Explanation: One or more sub-components are included in more than one group.

This results in a non-unique and therefore illegal situation.
Remedy: Redefine the indicated groups.

ERROR 8 NUMBER OF INSTRUMENTS TOO LARGE
Explanation: Actual number of instruments (Nins) exceeds 10.
Remedy: If possible, reduce the number of instruments to less than or equal to

10, for example by shortening the observation length.

ERROR 9 NUMBER OF SUBSERIES TOO LARGE
Explanation: Actual number of sub-series (Nsub) exceeds 10.
Remedy: See the remedy for Error 9.

ERROR 10-13 INACTIVE ERROR MESSAGES.

ERROR 14 MISSING INPUT LINE FOR BLOCK FILTER PARAMETERS
Explanation: Although the filter parameters are not used, the system expects this

input line.
Remedy: Add this input line. See section A.1.

ERROR 15 INPUT TIMESPECS FOR FIRST SUB-SERIES INCORRECT
Explanation: First sub-series lies before start of tidal series (TB)
Remedy: Verify and adjust date-time for first sub-series.

ERROR 16 INPUT TIMESPECS FOR LAST SUBSERIES INCORRECT
Explanation: Last sub-series lies after end of tidal series (TE)
Remedy: Verify and adjust date-time for last sub-series.

ERROR 17 INPUT TIMESPECS FOR SUB-SERIES INCORRECT
Explanation: The subsequent time levels (start and end time) for the instruments

are not monotonously increasing; some sub-series may be partly
overlapping or ill-placed.

Remedy: Verify and adjust date-time for sub-series.
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ERROR 18 SELECTED COMPONENT NOT ALLOWED
Explanation: The indicated component does not belong to the internal component

base listed in Appendix B. The component may be misspelled. Note
that the names of components must be given in upper cast (capital
letters).

Remedy: Correct the spelling. Compare the frequency of the component with
the list of names and frequencies in Appendix B, or remove this com-
ponent from the set.

ERROR 19 COMPONENTS WITH SAME FREQUENCY
Explanation: The two indicated components in your selected set have same tidal

frequency. That is not permitted.
Remedy: Remove one of the indicated components.

ERROR 20 INPUT AND DATA SET ARE INCONSISTENT W.R.T. SUB-SERIES
Explanation: In the input file you have specified date-time groups for beginning

and end of the sub-series. These time specifications should agree
with the actual sub-series as present on your <∗.obs> file. In case
of inconsistent specification parts of the gaps (periods between sub-
series) may become involved in the harmonic analysis.
To enable the sub-system to check for this situation we advise to
fill the gaps with unrealistic large numbers (say, 99999 or actually
any number > 1000). During the computation the sub-series will be
checked for these unrealistic numbers. Presence of these numbers
indicates that parts of gaps are involved in the sub-series, resulting
in the error message above.

Remedy: Check the Input Interpretation Report on your <∗.pri> file.
Make the time specifications for the sub-series on your input file con-
sistent with the <∗.obs> file.
Note: if the values of the real observations exceed 1000, e.g. when
they are given in e.g. millimetres, or have a very high mean, we sug-
gest an overall offset for the observations to realise values below
1000. Of course, the mean level and the hindcast should afterwards
be adjusted for the applied correction.

ERROR 21 READ-ERROR ON OBS FILE
Explanation: While reading the <∗.obs> file a read error occurred. Normally this

means that the system tries to read numbers and find characters on
the file. <∗.obs> files start with at least 1, and at most 20 header
lines, to identify the file.
Remember that you should start header lines with a ’+’ or a ’∗’. If
more than 20 header lines have been inserted, the situation above
will occur.

Remedy: Check the (number of) header lines at the start of the <∗.obs> file.
Check the Input Interpretation Report.
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ERROR 22 END OF FILE ON OBS FILE
Explanation: While reading the <∗.obs> file the system concluded that the pre-

scribed number of data on the input file (Nobs) was not available on
the <∗.obs> file. Normally this means that the value for Nobs is
incorrect; you may also have "lost" the last part of your observation
file.

Remedy: Verify and ensure that at least 1 header line is present on the
<∗.obs> file. Adjust the value for Nobs in the input file INA if this
does not correspond to the number of observations present on the
<∗.obs> file.

ERROR 23 DYNAMIC MEMORY ALLOCATION EXCEEDED
Explanation: In the system all data are allocated dynamically in a large dynamic

memory, resulting in optimal use of available memory. In Section
5.5 the limitations of the system were discussed. These summarised
limits should be read as individual limits, however, that is, a limit for
the number of components, a limit for the number of sub-series, etc.
All these individual limits are checked in the software. There is also
an overall memory limit, called the dynamic memory limit. This limit
corresponds to an overall maximum of 200 000 memory words.

Remedy: Adjust the input parameters of section A.1 where possible and fea-
sible, in order to reduce the dynamic memory required. First candi-
dates for reduction are Nobs, Ncomp, Nsub and Nins.

D.1.2 Warnings

Below two (non-fatal) warnings are discussed. Read the explanation carefully. Remember
that the software proceeds normally with the computation after detecting warnings.

WARNING 1 RAYLEIGH CRITERION VIOLATED
Explanation: The two indicated components are too close in frequency.

The Rayleigh criterion states that for independent resolution of all
components the minimum frequency difference (expressed in de-
grees per hour) for neighbouring tidal components should be 360/T ,
where T (in hours) is the effective length of the analysis period, see
section 8.3.3. The effective length T equals the difference between
the start date-time of the first sub-series and the end date-time of the
last sub-series.
This criterion does not always have to be applied so rigorously. Given
the nature of the least squares solution technique, a 10 % violation
of the criterion will generally not invalidate the results. See also the
chapter on theory chapter 8.

Remedy: If the violation is large, consider coupling of the two components in-
volved (if astronomically related), or removal of the less important
one of the two.

92 of 100 Deltares



DRAF
T

Messages from Delft3D-TIDE

WARNING 2 TIME STEP MAY BE INCORRECT
Explanation: From the input specifications for each instrument the time step (mea-

surement interval) will be reconstructed. For you, the correct speci-
fication of sequence numbers and corresponding time specifications
for the instruments is always a rather error-prone affair. Fortunately,
the software provides a check to see whether the computed time
step satisfies one of the time steps commonly used in tidal analysis.
These are time steps of 10, 15, 30 or 60 minutes. In the output this
appears as ∆t = 0.1666, 0.2500, 0.5000 or 1.0000 hours. If one of
the computed time steps is not exactly equal to one of these built-in
time steps a warning will be printed. Due to limited accuracy of com-
puters it is possible that the fourth decimal differs from these built-in
time steps. In that case, the warning should be ignored.

Remedy: Convince yourself whether the warning is caused by incorrect input
specification of date-time groups, or whether the clock of the record-
ing instrument has been off. In the latter case, the time step is correct
(the system can correct for this instrument error!). In the first case,
correct the input.

D.2 PREDICT

In PREDICT six error messages are implemented, and no warnings. After a complete screen-
ing of the input data the system will abort if any errors are detected. A list of the detected
errors is added to the print file <∗.prp>.

ERROR 1 END TIME < BEGIN TIME
Explanation This error arises when the input specification indicates that the date-

time group (TB) of the start of the prediction is later in time then the
date-time group (TE) for the end.

Remedy Verify and adjust the date-time groups.

ERROR 2 NUMBER OF COMPONENTS SHOULD BE BETWEEN 1 AND 234
Explanation The number of components (Ncomp) exceeds the maximum avail-

able number of components in the internal component base (=234).
Remedy Select any number of components in the range 1–234. Note that

the names of the components must be spelled conform the list in
Appendix B.

ERROR 3 NUMBER OF SUBSERIES SHOULD BE BETWEEN 1 AND 100.
Explanation You chose a number of sub-series (Nsub) not between 1 and 100.
Remedy Reduce the number of sub-series. If necessary, define sub-series

longer than two months (some loss of accuracy), or make several
computation runs.

ERROR 4 TIME LEVEL FOR SUBSERIES OUT OF RANGE
Explanation The date-time for the start of one of the sub-series (T1sub) is outside

the time range TB – TE for the prediction.
Remedy Verify your input and ensure that the start times of the sub-series lie

within the time range TB – TE of the prediction.
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ERROR 5 START OF SUBSERIES SHOULD BE ON A FULL HOUR OR A
MULTIPLE OF THE TIME STEP AFTER A FULL HOUR.

Explanation Each sub-series is supposed to start on a full hour or any number of
integer time steps after a full hour.

Remedy Adjust the date-time for the start of the concerned sub-series.

ERROR 6 COMPONENT xx NOT IN INTERNAL COMPONENT BASE.
Explanation The system does not recognise the component. Maybe the name

of the component is misspelled. Names should be entered in upper
cast.

Remedy Check the spelling of the component by comparing with Appendix B.
If necessary, replace it by the component from the database that has
the same or comparable frequency.

D.3 HILOW

In this section the list of possible error messages of HILOW is given. All error messages will
cause the sub-system to abort. Again, only error messages related to relevant input will be
listed.

D.3.1 Error messages

ERROR 1 NUMBER OF OBSERVATIONS EQUALS ./ SHOULD BE LESS
THAN 18000.

Explanation The number of values (Nobs) that you specified in the input file ex-
ceeds 18 000.

Remedy Restrict the number of observations in HILOW, either by shortening
the series, or dropping every other half hourly value if applicable.
Hourly values suffice in the determination of tide tables. Note that a
full year of half-hourly values corresponds to Nobs = 17 520 (17 568
for a leap year).

ERROR 2 TOO MANY INSTRUMENTS
Explanation Actual number of instruments (Nins) exceeds 10.
Remedy If possible, reduce the number of instruments to less than or equal to

10, for example by shortening the observation length.

ERROR 3 TOO MANY SUBSERIES
Explanation Actual number of sub-series (Nsub) exceeds 10.
Remedy See the remedy for Error 2.

ERROR 4 NO FILTER PARAMETERS PROVIDED
Explanation The input line for the 3 filter parameters is missing.
Remedy Add the input line for the filter parameters, see section A.3.

ERROR 5 FILTER PARAMETERS INCORRECT
Explanation While reading the filter parameters, the system detected a read error.

In this situation the most likely explanation is that you did not enter
integer numbers for Mfilter and Nfilter.

Remedy Choose integer values for filter parameter Mfilter and Nfilter.
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D.3.2 Info messages

The sub-system may generate some informative messages for the block filter.

MESSAGE 1 BLOCK FILTER PAR. 1 OUT OF RANGE (RESET ON DE-
FAULT=0.2).

MESSAGE 2 BLOCK FILTER PAR. 2 OUT OF RANGE (RESET ON DE-
FAULT=2).

MESSAGE 3 BLOCK FILTER PAR. 3 OUT OF RANGE (RESET ON DE-
FAULT=2).

Parameters 1, 2, and 3 refer to Afilter, Mfilter and Nfilter, resp. If the default does not satisfy,
verify their ranges, see the example input file in item A.3.

D.4 ASCON

ASCON contains three error messages.

ERROR 1 ALL TIME-DATES INCORRECT
Explanation Date-time groups in input were specified incorrectly or not present at

all.
Remedy Adjust or add date-time group(s) for computing the V0 + u and F .

ERROR 2 ALL SUPPLIED COMPONENTS INCORRECT.
Explanation Components missing or misspelled.
Remedy Adjust or add components, see Appendix B.

ERROR 3 COMPONENT xx NOT IN INTERNAL COMPONENT BASE.
Explanation The system does not recognise the component. Maybe the name

of the component is misspelled. Names should be entered in upper
cast.

Remedy Check the spelling of the component. If necessary, replace it by the
component from the database that has the same or comparable fre-
quency.

Remark:
� The constituent names must be entered in order of increasing frequency.

.

D.5 FOURIER

No errors or warnings are listed.
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E Content of the TIDE tutorial cases

A list of the input files of the tutorial cases is given below.

E.1 ANALYSIS

For sub-system ANALYSIS in directory <tutorial\tide\analysis>

� sub-directory <example_1> with files:

� <anaex1.ina>
� <hvh.obs>

� sub-directory <example_2> with files:

� <anaex2.ina>
� <hvh.obs>

� sub-directory <example_3> with files:

� <anaex3.ina>
� <bermud.obs>

� sub-directory <example_4> with files:

� <anaex4.ina>
� <atlantis.obs>

E.2 PREDICT

For sub-system PREDICT in directory <tutorial\tide\prediction>

� sub-directory <example_1> with file:

� <prdex1.inp>

� sub-directory <example_2> with file:

� <prdex2.inp>

E.3 HILOW

For sub-system HILOW in directory <tutorial\tide\hilow>

� sub-directory <example_1> with files:

� <hlwex1.inh>
� <prdex1.prd>

� sub-directory <example_2> with files:

� <hlwex2.inh>
� <anaex2.hdc>

� sub-directory <example_3> with files:

� <hlwex3.inh>
� <bermuda.obs>
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E.4 ASCON

For sub-system ASCON in directory <tutorial\tide\ascon>

� sub-directory <example_1> with file:

� <ascex1.inc>

� sub-directory <example_2> with file:

� <ascex2.inc>

E.5 FOURIER

For sub-system FOURIER in directory <tutorial\tide\fourier>

� sub-directory <example_1> with file:

� <anaex3.res>

� sub-directory <example_2> with file:

� <sft_fouex2.res>

� sub-directory <example_3> with file:

� <fft_fouex3.res>
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